[image: image1.png]The Meeting Transcript of
The Los Angeles County
Board of Supervisors




[image: image2.png]The Meeting Transcript of
The Los Angeles County Board of Supervisors




July 2, 2013


[image: image3.png]The Meeting Transcript of
The Los Angeles County Board of Supervisors





          Adobe Acrobat Reader 

Finding Words

You can use the Find command to find a complete word or part of a word in the current PDF document.  Acrobat Reader looks for the word by reading every word on every page in the file, including text in form fields.

To find a word using the Find command:

1. Click the Find button (Binoculars), or choose Edit > Find.

2. Enter the text to find in the text box.

3. Select search options if necessary:

Match Whole Word Only finds only occurrences of the complete word you enter in the box.  For example, if you search for the word stick, the words tick and sticky will not be highlighted.

Match Case finds only words that contain exactly the same capitalization you enter in the box.

Find Backwards starts the search from the current page and goes backwards through the document.

4. Click Find.  Acrobat Reader finds the next occurrence of the word.

To find the next occurrence of the word, Do one of the following:

            Choose Edit > Find Again 

            Reopen the find dialog box, and click Find Again. 

            (The word must already be in the Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it into another application such as a word processor.  You can also paste text into a PDF document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you can switch to another application and paste it into another document.  

Note:  If a font copied from a PDF document is not available on the system displaying the copied text, the font cannot be preserved.  A default font  is substituted.

To select and copy it to the clipboard:

1. Select the text tool T, and do one of the following:

       To select a line of text, select the first letter of the sentence or phrase and drag to

       the last letter.  

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option (Mac OS) as you drag across the width of the document. 

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command (Mac OS) as you drag the length of the document.

To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text on the current page is selected.  In Continuous or Continuous – facing mode, most of the text in the document is selected.  When you release the mouse button, the selected text is highlighted.  To deselect the text and start over, click anywhere outside the selected text.  

The Select All command will not select all the text in the document.  A workaround for this (Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected text to the clipboard.

2. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.

[There is no reportable action as a result of the

Board of Supervisors' closed session held today.]
SUP. RIDLEY-THOMAS, CHAIRMAN: GOOD MORNING TO EVERYONE. I WANT TO ASK THAT WE BEGIN IN AN APPROPRIATE WAY TODAY, IF YOU WOULD JUST SIMPLY RISE FOR A MOMENT OF SILENCE AND ACKNOWLEDGMENT AND MEMORY OF THE FIREFIGHTERS WHO LOST THEIR LIVES IN THE LINE OF DUTY, INCLUDING KEVIN WOYJECK, SON OF OUR OWN L.A. COUNTY FIRE CAPTAIN, JOE WOYJECK, IT SEEMS TO ME THAT A MOMENT OF SILENCE IS MOST APPROPRIATE, AND IF YOU WOULD JOIN ME IN THAT SPIRIT. (MOMENT OF SILENCE OBSERVED). WE SAY THANK YOU. AT THE INVITATION OF THE FOURTH DISTRICT, SUPERVISOR DON KNABE WILL HAVE THE REVEREND DEBORAH JAMESON, LIFEGATE FOURSQUARE CHURCH OF PARAMOUNT TO GIVE THIS MORNING'S INVOCATION, FOLLOWED BY ROBERTA ROBLES, A MEMBER OF POST NUMBER 43 IN HOLLYWOOD, THE AMERICAN LEGION, AT THE INVITATION OF THIRD DISTRICT SUPERVISOR, ZEV YAROSLAVSKY. REVEREND? 

REV. DEBORAH JAMESON: THANK YOU. COULD YOU BOW YOUR HEADS WITH ME, PLEASE? WE COME BEFORE YOU TODAY, HEAVENLY FATHER. OUR HEARTS ARE HEAVY AT THE LOSS OF OUR FIREFIGHTERS, SOME FROM THIS COUNTY, SOME FROM OTHER PLACES. AND WE LIFT UP THEIR FAMILIES TO YOU TODAY, LORD. AND WE ASK THAT YOU WOULD COMFORT, YOU WOULD GIVE ANSWERS WHERE THERE'S NO ANSWERS, YOU'D BRING PEACE, YOU WOULD BRING CONSOLATION TO THOSE TODAY, THE FAMILIES, THE FRIENDS, THE FELLOW FIREFIGHTERS, ALL WHO ARE IN ACQUAINTANCE WITH ANY OF THESE THAT HAVE BEEN TAKEN BY THIS FIRE. LORD, WE KNOW THAT YOU ARE WITH THEIR FAMILIES TODAY. WE ASK FOR OUR COUNTY BOARD OF SUPERVISORS TODAY THAT YOU WILL CONTINUE TO GUIDE THEM, DIRECT THEM, LEAD THEM AS THEY MAKE DECISIONS FOR US WHO LIVE IN L.A. COUNTY, FOR THOSE OF US WHO CALL THIS OUR HOME, THAT AS THEY MAKE DECISIONS, THAT THEY WILL BENEFIT ALL OF US. WE ASK TODAY, LORD, THAT YOU WOULD JUST GIVE US A BREEZE OF YOUR SPIRIT, A COOLING OFF THE WEATHER AND THAT WE WILL BE ABLE TO ENJOY THE THINGS THAT YOU HAVE PROMISED US IN YOUR WORD. THAT THIS IS THE DAY THAT YOU HAVE MADE AND WE WILL REJOICE IN IT AND WE WILL WORSHIP YOU IN IT TODAY. WE GIVE YOU PRAISE FOR THESE THINGS, AMEN. 

SUP. RIDLEY-THOMAS, CHAIRMAN: AMEN. 

ROBERTA L. ROBLES: PLEASE JOIN ME IN THE PLEDGE OF ALLEGIANCE BY PLACING YOUR RIGHT HAND OVER YOUR HEART, AND THOSE VETERANS, PLEASE, YOU CAN SALUTE, COVERED OR UNCOVERED. READY, BEGIN. [PLEDGE OF ALLEGIANCE RECITED.] THANK YOU. 

SUP. RIDLEY-THOMAS, CHAIRMAN: SUPERVISOR KNABE, PLEASE. 

SUP. KNABE: THANK YOU, MR. CHAIRMAN, MEMBERS OF THE BOARD, IT'S MY PRIVILEGE TO WELCOME A GOOD FRIEND, THE REVEREND DEBORAH JAMESON FROM THE LIFEGATE FOURSQUARE CHURCH IN PARAMOUNT, WHO TOOK THE TIME TO LEAD US IN THE INVOCATION THIS MORNING. REVEREND JAMESON, ALSO KNOWN AS PASTOR D., HAS BEEN IN FULL-TIME MINISTRY FOR 34 YEARS, WITH HER BEGINNINGS AT ANGELUS TEMPLE AS A COLLEGE-AGE PASTOR. SHE WAS APPOINTED CO-PASTOR AT THE DOWNEY AVENUE PARAMOUNT FOURSQUARE CHURCH IN SEPTEMBER OF 1986. FOR THE PAST 29 YEARS, SHE HAS SERVED ON THE NATIONAL BOARD OF FOURSQUARE WOMEN INTERNATIONAL AND HAS TRAVELED THROUGHOUT THE UNITED STATES AS WELL AS BRAZIL, MEXICO, PAPUA NEW GUINEA, GREECE, MINISTERING AND SPEAKING TO WOMEN'S GROUPS. SHE IS ALSO AN AMBASSADOR OF THE PARAMOUNT CHAMBER OF COMMERCE WHERE SHE SERVES TO PROMOTE BUSINESS AND GROWTH AND PARTICIPATION IN THE CITY'S ACTIVITIES. HER MOST RECENT APPOINTMENT WAS TO THE LIFE PACIFIC COLLEGE REGIONAL COUNCIL, HELPING TO DEFINE ITS MISSION IN TRAINING LEADERS. SHE IS THE MOTHER OF TWO ADULT CHILDREN, CARLY AND LUCAS, WHO ALONG WITH THEIR SPOUSES ARE VERY ACTIVE IN THEIR MINISTRY OF LIFEGATE WHERE SHE SERVES ALONGSIDE HER HUSBAND LARRY AS CO-PASTORS. THIS PAST MAY, SHE RECEIVED GOD'S BLESSINGS BY BECOMING A GRANDMA TO ANNABEL GRACE. SO ON BEHALF OF MY COLLEAGUES AND THE MILLIONS OF RESIDENTS HERE IN LOS ANGELES COUNTY, WE WANT TO THANK PASTOR JAMESON FOR TAKING THE TIME TO LEAD US IN OUR INVOCATION THIS MORNING. [APPLAUSE.] 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU, SUPERVISOR KNABE. SUPERVISOR YAROSLAVSKY, PLEASE. 

SUP. YAROSLAVSKY: MR. CHAIRMAN, WE WERE LED IN THE PLEDGE OF ALLEGIANCE THIS MORNING BY ROBERTA ROBLES, A RESIDENT OF PACOIMA IN OUR DISTRICT. SHE IS REPRESENTING THE AMERICAN LEGION POST 43. SHE SERVED IN THE UNITED STATES NAVY FROM 1975 TO 1980. SHE RECEIVED THE GOOD CONDUCT MEDAL, ATTAINED THE RANK OF E-4. SHE CURRENTLY IS A VOLUNTEER IN THE MILITARY AND VETERANS AFFAIRS IN LOS ANGELES COUNTY. SHE IS A GRADUATE OF MONTEBELLO HIGH SCHOOL AND AZUSA PACIFIC UNIVERSITY. SO, ROBERTA, WE'D LIKE TO -- THAT'S RINGO, RIGHT? HER SERVICE DOG RINGO, WHO SAID THE PLEDGE OF ALLEGIANCE ABSOLUTELY PERFECTLY, THANK YOU, RINGO. ROBERTA, COME OVER HERE AND LET ME PRESENT YOU WITH THIS CERTIFICATE. THANK YOU FOR LEADING US IN THE PLEDGE AND THANK YOU FOR YOUR SERVICE OF OUR COUNTRY. [APPLAUSE.] 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU, SUPERVISOR YAROSLAVSKY. WE'LL PROCEED WITH THE CALLING OF THE AGENDA, MADAM EXECUTIVE OFFICER, PLEASE. 

SACHI HAMAI, EXEC. OFFICER: THANK YOU, GOOD MORNING, MR. CHAIRMAN, MEMBERS OF THE BOARD, WE WILL BEGIN TODAY'S AGENDA ON PAGE 2, PRESENTATIONS AND SET MATTERS. ON ITEM S-1, AS INDICATED ON THE SUPPLEMENTAL AGENDA, SUPERVISOR RIDLEY-THOMAS REQUESTS THAT THIS ITEM BE CONTINUED TO JULY 30, 2013. AND ON THIS ITEM, THERE'S A REQUEST FROM MEMBERS OF THE PUBLIC TO HOLD IT. ON PAGE 3, AGENDA FOR THE MEETING OF THE COMMUNITY DEVELOPMENT COMMISSION. ON ITEM NO. 1-D, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON PAGE 4, BOARD OF SUPERVISORS, ITEMS 1 THROUGH 14, ON ITEM NO. 1, ON SUPERVISOR KNABE'S APPOINTMENT OF GREGORY C. O'BRIEN TO THE RANCHO PALOS VERDES REDEVELOPMENT DISSOLUTION OVERSIGHT BOARD, SUPERVISOR ANTONOVICH WILL VOTE NO ON THIS APPOINTMENT. AND ALSO ON THIS ITEM, THERE'S REQUESTS FROM MEMBERS OF THE PUBLIC TO HOLD IT. ON ITEM NO. 3, AS INDICATED ON THE SUPPLEMENTAL AGENDA, SUPERVISOR RIDLEY-THOMAS REQUESTS THAT THIS ITEM BE CONTINUED TWO WEEKS TO JULY 16, 2013, AND ON THIS ITEM, THERE'S REQUESTS FROM MEMBERS OF THE PUBLIC TO HOLD THE ITEM. ON ITEM NO. 9, THERE'S A REQUEST FROM MEMBERS OF THE PUBLIC TO HOLD THIS ITEM. AND ON ITEM NO. 11, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. THE REMAINING ITEMS UNDER THE BOARD OF SUPERVISORS ARE BEFORE YOU. 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU VERY MUCH. SUPERVISOR KNABE MOVES. SUPERVISOR MOLINA SECONDS AS HAS BEEN INDICATED BY THE EXECUTIVE OFFICER. 

SACHI HAMAI, EXEC. OFFICER: THANK YOU. ON PAGE 9, CONSENT CALENDAR, ITEMS 15 THROUGH 55. ON ITEM NO. 15, SUPERVISOR ANTONOVICH AND MEMBERS OF THE PUBLIC REQUEST THAT THIS ITEM BE HELD. 15. ON ITEM NO. 16, AS INDICATED ON THE SUPPLEMENTAL AGENDA, THE CHIEF EXECUTIVE OFFICER REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO JULY 9, 2013. ON ITEM NO. 17, THERE'S A REQUEST FROM MEMBERS OF THE PUBLIC TO HOLD THIS ITEM. ON ITEMS NO. 18 AND 19, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THESE ITEMS. ON ITEM NO. 22, AS INDICATED ON THE SUPPLEMENTAL AGENDA, THE DIRECTOR OF HEALTH SERVICES REQUESTS THAT THIS ITEM BE CONTINUED TWO WEEKS TO JULY 16, 2013. AND ON THIS ITEM, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD IT. ON ITEM NO. 23, THE DIRECTOR OF MENTAL HEALTH REQUESTS THAT THIS ITEM BE CONTINUED TWO WEEKS TO JULY 16, 2013. AND AGAIN NO THIS ITEM, THERE'S A REQUEST FROM MEMBERS OF THE PUBLIC TO HOLD THE ITEM. ON ITEM NO. 24 AS INDICATED ON THE SUPPLEMENTAL AGENDA, THE DIRECTOR OF MENTAL HEALTH REQUESTS THAT THIS BE CONTINUED TWO WEEKS TO JULY 16, 2013. AGAIN THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 25, THERE'S A REQUEST FROM MEMBERS OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 34 AND 35, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THESE ITEMS. ON ITEM NO. 40, AS INDICATED ON THE SUPPLEMENTAL AGENDA, THE CHIEF EXECUTIVE OFFICER REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO JULY 9, 2013. AND ALSO ON THIS ITEM, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD IT. ON ITEM NO. 41, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 44, AS INDICATED ON THE SUPPLEMENTAL AGENDA, THE REGISTRAR-RECORDER/COUNTY CLERK REQUESTS THAT THIS ITEM BE TAKEN OFF CALENDAR. AND ON THIS ITEM THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD IT. ON ITEM NO. 47, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. AND ON ITEM NO. 48, AS INDICATED ON THE SUPPLEMENTAL AGENDA, THE REGISTRAR-RECORDER/COUNTY CLERK REQUESTS THAT THIS ITEM BE TAKEN OFF CALENDAR. ON ITEM NO. 54 AND 55 THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THESE ITEMS. AND THE REMAINING ITEMS UNDER THE CONSENT CALENDAR ARE BEFORE YOU. 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU VERY MUCH. SUPERVISOR ANTONOVICH MOVES. SUPERVISOR YAROSLAVSKY SECONDS. IF THERE ARE NO OBJECTIONS, PLEASE RECORD A UNANIMOUS VOTE. 

SACHI HAMAI, EXEC. OFFICER: ON PAGE 22, ORDINANCES FOR INTRODUCTION, ITEM NO. 56 AND 57. ON ITEM NO. 56, I'LL READ THE SHORT TITLE IN FOR THE RECORD. THIS IS AN ORDINANCE FOR INTRODUCTION AMENDING THE COUNTY CODE, TITLE 6, SALARIES, BY CHANGING THE SALARY OF ONE UNCLASSIFIED CLASSIFICATION AND ADDING, DELETING AND/OR CHANGING CERTAIN CLASSIFICATIONS AND NUMBERS OF ORDINANCE POSITIONS. ON THIS ITEM THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD IT. ON ITEM NO. 57, AGAIN, I'LL READ THE SHORT TITLE IN FOR THE RECORD. THIS IS AN ORDINANCE FOR INTRODUCTION AMENDING THE COUNTY CODE. TITLE 15, VEHICLES AND TRAFFIC RELATING TO THE RESTRICTION OF PARKING VEHICLES UPON CERTAIN COUNTY STREETS FOR THE PRIMARY PURPOSE OF ADVERTISING SUCH VEHICLES FOR SALE TO ADD ADDITIONAL STREETS MEETING THE CRITERIA FOR THIS RESTRICTION AND TO DELETE OTHER STREETS THAT NO LONGER MEET THE CRITERIA FOR THIS RESTRICTION. THIS ITEM IS BEFORE YOU. 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU VERY MUCH. SUPERVISOR ANTONOVICH MOVES. SUPERVISOR MOLINA SECONDS. IF THERE ARE NO OBJECTIONS, PLEASE RECORD A UNANIMOUS VOTE. 

SACHI HAMAI, EXEC. OFFICER: ON PAGE 23, DISCUSSION ITEMS, ITEMS 58 AND 59. ON ITEM NO. 58, AS INDICATED ON THE SUPPLEMENTAL AGENDA, THE CHIEF EXECUTIVE OFFICER AND THE DIRECTOR OF HEALTH SERVICES REQUEST THAT THIS ITEM BE CONTINUED THREE WEEKS TO JULY 23, 2013. AND ON THIS ITEM, THERE'S A REQUEST FROM MEMBERS OF THE PUBLIC TO HOLD IT. ON ITEM NO. 59, THIS IS A PUBLIC HEARING ITEM, AS INDICATED ON THE SUPPLEMENTAL AGENDA. AND TO CLARIFY SUPERVISOR ANTONOVICH'S REQUEST, SUPERVISOR ANTONOVICH REQUESTS THAT SECTIONS 1 THROUGH 4 OF THE ORDINANCE PERTAINING TO THE ANIMAL KEEPERS WHICH RESPECTIVELY AMEND LOS ANGELES COUNTY CODE SECTIONS 8.04.030 CATEGORY 1, 8.04.035 CATEGORY 2, 8.04.040, CATEGORY 3 AND 8.04.050 B EXCEPTIONS TO BE STRICKEN FROM THE ORDINANCE AND CONTINUED TO JULY 30 FOR INTRODUCTION AND PLACEMENT ON THE JULY -- ACTUALLY THE FIRST AUGUST MEETING BOARD'S AGENDA FOR ADOPTION. AND ON THIS ITEM, THE REMAINING PORTION WILL BE HELD FOR THE PUBLIC HEARING. THERE'S MEMBERS OF THE PUBLIC THAT WILL SPEAK ON IT. ON PAGE 24, MISCELLANEOUS ADDITIONS TO THE AGENDA WHICH WERE POSTED MORE THAN 72 HOURS IN ADVANCE OF THE MEETING AS INDICATED ON THE SUPPLEMENTAL AGENDA. ON ITEM NO. 60-A, THERE'S A REQUEST FROM MEMBERS OF THE PUBLIC TO HOLD THIS ITEM. 60-B IS BEFORE YOU. 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU VERY MUCH. THIS IS BEFORE US. SUPERVISOR KNABE MOVES. SUPERVISOR YAROSLAVSKY SECONDS. IF THERE ARE NO OBJECTIONS, PLEASE RECORD A UNANIMOUS VOTE. 

SACHI HAMAI, EXEC. OFFICER: AND ITEM NO. 60-C. 

SUP. RIDLEY-THOMAS, CHAIRMAN: 60-C IS BEFORE US. SUPERVISOR MOLINA MOVES AND SUPERVISOR ANTONOVICH SECONDS. IF THERE ARE NO OBJECTIONS, PLEASE RECORD A UNANIMOUS VOTE. 

SACHI HAMAI, EXEC. OFFICER: ON PAGE 27, NOTICES OF CLOSED SESSION. ON ITEM NO. CS-2, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. AND THAT COMPLETES THE READING OF THE AGENDA. BOARD OF SUPERVISORS, SPECIAL ITEMS BEGIN WITH SUPERVISORIAL DISTRICT NO. 1. 

SUP. YAROSLAVSKY: MR. CHAIRMAN, BEFORE WE GO ON, ON ITEM NO. 1, ON THE APPOINTMENTS TO THE COMMISSION ON H.I.V., IS THAT APPROVED? 

SACHI HAMAI, EXEC. OFFICER: IT'S BEING HELD FOR MEMBERS OF THE PUBLIC RIGHT NOW. 

SUP. YAROSLAVSKY: OKAY, I'M GOING TO ASK AFTER WE HEAR FROM MEMBERS OF THE PUBLIC THAT WE CONTINUE IT ONE WEEK. 

SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. 

SUP. YAROSLAVSKY: JUST THAT ITEM, THAT PART OF IT. 

SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. THANK YOU VERY MUCH. LADIES AND GENTLEMEN, I'M PLEASED TO BRING FORWARD A GOOD FRIEND, THE CONSUL GENERAL OF CHINA, THE ONE AND ONLY, THE HONORABLE QUI SHAOFONG. AND FOR TWO AND A HALF YEARS THE CONSUL GENERAL HAS HEADED ONE OF THE LARGEST CONSULATES IN LOS ANGELES, SERVING A JURISDICTION THAT INCLUDES SOUTHERN CALIFORNIA, ARIZONA, NEW MEXICO, HAWAII AND THE AMERICAN PACIFIC ISLANDS. IN ADDITION TO THE MANY RESPONSIBILITIES HE HAS FOR RESPONDING TO THE WELL-BEING OF THE CHINESE AND CHINESE-AMERICAN COMMUNITIES IN HIS JURISDICTION, THE CONSUL GENERAL HAS ALSO BEEN ACTIVE IN PROMOTING PERSON-TO-PERSON DIPLOMACY. FOR EXAMPLE, THE YEAR 2012, HE HELD A RECEPTION AT HIS RESIDENCE FOR REPRESENTATIVES FROM SEVERAL AMERICAN CITIES UNDER HIS JURISDICTION THAT HAVE SISTER CITY RELATIONSHIPS WITH CHINESE CITIES WHICH INCLUDED OF COURSE LOS ANGELES, ALHAMBRA, SAN DIEGO AND PHOENIX. HE'S ORGANIZED NUMEROUS CULTURAL EVENTS, INCLUDING THE UNVEILING OF A SCULPTURE BY A FAMOUS CHINESE ARTIST COMMEMORATING CHINESE RAILROAD CONSTRUCTION WORKERS FOR THE NATIONAL TRAIN DAY AT UNION STATION LAST YEAR, A MEMORABLE EVENT. HE HAS ALSO HOSTED NUMEROUS RECEPTIONS IN HONOR OF NATIONAL AND INTERNATIONAL HOLIDAYS, INCLUDING ONE FOR INTERNATIONAL WOMEN'S DAY THIS LAST MARCH. AND SO IT'S ON BEHALF OF THE BOARD OF SUPERVISORS AND OUR MORE THAN 10 MILLION RESIDENTS THAT I THANK YOU, SIR, FOR YOUR UNTIRING LEADERSHIP AND PROMOTING WARM RELATIONSHIPS BETWEEN THE PEOPLE OF CHINA AND THE RESIDENTS OF LOS ANGELES COUNTY. AND I WISH TO EXPRESS ON BEHALF OF THE ENTIRE BOARD YOUR CONTINUING SUCCESS AND WISH YOU WELL AS YOU DEPART THIS POST AND HEAD BACK TO YOUR HOMELAND OF CHINA. WE THANK YOU VERY MUCH AND WE WISH YOU GODSPEED. THANK YOU. [APPLAUSE.] 

HON. QUI SHAOFONG: HONORABLE CHAIRMAN OF THE BOARD, SUPERVISOR MARK RIDLEY-THOMAS, HONORABLE SUPERVISOR GLORIA MOLINA, SUPERVISOR ZEV YAROSLAVSKY, SUPERVISOR DON KNABE, AND SUPERVISOR MICHAEL ANTONOVICH, LADIES AND GENTLEMEN, GOOD FRIENDS. THIS IS MY GREAT PLEASURE AND PRIVILEGE TO HERE. I'LL NEVER FORGET MORE THAN 2-1/2 YEARS AGO HERE YOU HAD THE SAME CEREMONY TO WELCOME MY, THE FIRST TIME TO ARRIVE IN L.A. COUNTRY. TODAY, YOU ARE ALSO HOLDING A FAREWELL CEREMONY FOR ME TODAY. THIS MIGHT BE MY LAST TIME TO SPEAK IN FRONT OF SO MANY LOS ANGELES FRIENDS AND ALSO MY LAST TIME TO MEET ALL THE FIVE SUPERVISORS, HONORABLE SUPERVISORS OF LOS ANGELES COUNTY ON THIS OCCASION. OVER THE PAST 2-1/2 YEARS, SERVING AS THE CONSUL GENERAL OF CHINA IN LOS ANGELES, WHAT HAS MOST IMPRESSED ME MOST IS HOSPITALITY, DIVERSITY AND VITALITY OF THIS GREAT COUNTY, THE COUNTY OF LOS ANGELES AND THE GREAT LEADERSHIP OF THE BOARD OF SUPERVISORS. LOS ANGELES COUNTY HAS LED THE COUNTRY IN ECONOMY RECOVERY. I WOULD LIKE TO PAY TRIBUTE TO YOU, ALL THE GOOD JOB YOU HAVE DONE. LADIES AND GENTLEMEN, THE PAST TWO YEARS, THE PAST 2-1/2 YEARS HAVE WITNESSED THE FAST-GROWING RELATIONS BETWEEN CHINA AND L.A. COUNTY. IN 2012, THE TRADE WHEN BETWEEN CHINA AND THE L.A. -- DISTRICT REACHED 152.4 BILLION U.S. DOLLARS, ACCOUNTING FOR 40 PERCENT OF THE TOTAL TRADE OF LOS ANGELES -- DISTRICT AND 30 PERCENT OF CHINA U.S. TRADE RESPECTIVELY. -- IS TO OPEN AND -- CELEBRATE THE -- LUNAR NEW YEAR, L.A. COUNTY BOOST THE LARGE CHINESE COMMUNITY IN THIS COUNTRY, WHOSE HARD WORK HAS CONTRIBUTED TO YOUR GREAT COUNTY. HONORABLE SUPERVISORS, AS A DIPLOMAT, ONE OF THE MOST IMPORTANT TASKS IS TO MAKE FRIENDS, ESPECIALLY FOR AMBASSADORS AND CONSUL GENERALS. YOU ARE THE SUPERVISORS AND PROMOTERS OF CHINA-U.S. RELATIONS. I AM LUCKY AND PRIVILEGED TO HAVE YOU AS MY GOOD FRIENDS DURING MY ASSIGNMENTS IN LOS ANGELES. I WOULD LIKE TO TAKE THIS OPPORTUNITY TO EXPRESS MY DEEPEST GRATITUDE FOR YOUR SUPPORT AND ASSISTANCE FOR THE CHINESE CONSULATE IN LOS ANGELES AND MYSELF AND HOPE THAT YOU WILL CONTINUE TO RENDER YOUR SUPPORT TO MY SUCCESSORS AND THE CONSULATE. ALTHOUGH I WILL GO BACK TO BEIJING THIS MONTH, I WILL STILL KEEP EYES ON THE COOPERATION BETWEEN CHINA AND UNITED STATES, ESPECIALLY THE COUNTY OF L.A. AND EXPECT THAT SOMEDAY WE WILL SEE EACH OTHER IN BEIJING OR EITHER IN LOS ANGELES AGAIN. IN CONCLUSION, I WISH THAT CHINA-U.S. FRIENDSHIP AND CHINA-L.A. COUNTY COOPERATION WILL LAST FOREVER AND THE BEST FOR YOU. THANK YOU VERY MUCH. THANK YOU. [APPLAUSE.] 

SUP. ANTONOVICH: MR. CHAIRMAN, LET ME JUST SAY THAT AMBASSADOR QUI SHAOFONG, PRIOR TO COMING HERE AS THE CONSUL GENERAL WAS THE PEOPLE'S REPUBLIC OF CHINA'S AMBASSADOR TO SINGAPORE. SO HE'S HAD A DISTINGUISHED CAREER IN THE FOREIGN SERVICE REPRESENTING HIS COUNTRY AND NATION AS AN AMBASSADOR AND BEING INVOLVED IN MANY IMPORTANT ISSUES. WE APPRECIATED HIS FRIENDSHIP AND LEADERSHIP IN OUR COMMUNITY AND, IN TURN, ALSO WORKING WITH THE OTHER CONSUL GENERALS IN LOS ANGELES COUNTY, WHICH SERVES NOT JUST L.A. COUNTY BUT A GREAT DEAL OF THE UNITED STATES. SO WE WILL MISS YOU. WE APPRECIATE YOUR PAST LEADERSHIP HERE AND FRIENDSHIP AND LOOK FORWARD TO CONTINUING OUR FRIENDSHIP AS YOU ASSUME YOUR RESIDENCY IN BEIJING. SO GOD BLESS YOU. [APPLAUSE.] 

SUP. RIDLEY-THOMAS, CHAIRMAN: COLLEAGUES, WE ALSO TAKE THE OPPORTUNITY TO ACKNOWLEDGE THE HONORABLE BRUNO RYFF, CONSUL GENERAL OF SWITZERLAND HERE IN LOS ANGELES, AND TO SAY SINCE OCTOBER OF 2009, THE CONSUL GENERAL HAS BEEN IN CHARGE OF NUMEROUS RESPONSIBILITIES RELATING TO THE WELL-BEING OF SWISS AND SWISS-AMERICAN RESIDENTS AS WELL AS OUR INTERNATIONAL CORPORATIONS AND BUSINESS PROFESSIONALS IN SOUTHERN CALIFORNIA AND ARIZONA. HE HEADS AN ACTIVE TRADE SECTION THAT MAKES INFORMATION AVAILABLE TO CALIFORNIA-BASED FIRMS AND INDIVIDUALS WHO ARE INTERESTED IN BUSINESS OR FINANCE IN SWITZERLAND AS WELL AS HELPING SWISS FIRMS BECOME MORE KNOWLEDGEABLE ABOUT BUSINESS OPPORTUNITIES IN SOUTHERN CALIFORNIA AND ARIZONA. HE'S ALSO HOSTED NUMEROUS EVENTS PROMOTING SWISS ARTS AND CULTURE. FOR EXAMPLE, AT THE BEGINNING OF JUNE, THE L.A. COUNTY MUSEUM OF ART OPENED AN EXHIBITION, THE MOST NOTABLE PROJECT CELEBRATED SWISS ARCHITECT PETER ZUMTHOR. THIS IS OF SPECIAL INTEREST BECAUSE THE ARCHITECT HAS BEEN COMMISSIONED TO REDESIGN THE EAST CAMPUS OF L.A.C.M.A. THE CONSUL GENERAL HAS ALSO MAINTAINED A BUSY CALENDAR OF PRESENTATIONS OF SWISS FILMS, FINE ARTS AND VISUAL ARTS, AS WELL, MUSIC AT VARIOUS LOCAL THEATERS AND MUSEUMS. SO IT'S ON BEHALF OF THE ENTIRE BOARD AND ALL OF THE PEOPLE OF L.A. COUNTY THAT WE WISH TO THANK CONSUL GENERAL RYFF FOR HIS DEDICATED LEADERSHIP IN PROMOTING THE IMPORTANT RELATIONSHIPS BETWEEN THE PEOPLE OF SWITZERLAND AND THE RESIDENTS OF LOS ANGELES COUNTY. WE TAKE THIS OPPORTUNITY TO WISH YOU SUCCESS AS YOU DEPART THIS POST AND RETURN TO YOUR NATIVE LAND OF SWITZERLAND. [APPLAUSE.] 

HON. BRUNO RYFF: HONORABLE CHAIRMAN RIDLEY-THOMAS, HONORABLE MEMBERS OF THE BOARD OF SUPERVISORS, THANK YOU SO MUCH FOR THE KIND INTRODUCTION AND FOR THIS WONDERFUL OPPORTUNITY TO SAY GOODBYE. IN CONTRAST TO MY ESTEEMED CHINESE COLLEAGUE, I'M REPRESENTING A VERY SMALL COUNTRY. IN THOSE PAST YEARS OF ECONOMIC, WORLDWIDE ECONOMIC CONFLICT, SWITZERLAND HAS DONE VERY WELL, WE HAD SOLID ECONOMIC GROWTH, BALANCED BUDGET, LOW UNEMPLOYMENT OF 3 PERCENT, YOUTH UNEMPLOYMENT OF 3.2 PERCENT. AND THIS HAD A POSITIVE IMPACT ON SWISS-U.S. ECONOMIC RELATIONS. AS A MATTER OF FACT, SWITZERLAND HAS BECOME IN 2011 THE NUMBER ONE FOREIGN DIRECT INVESTOR IN THE UNITED STATES, FURTHER ADDING TO THE STOCK OF DIRECT INVESTMENTS OF OVER $200 BILLION, REPRESENTING ABOUT 350,000 WELL-PAID JOBS FOR AMERICAN MEN AND WOMEN. TWO PRIME EXAMPLES HERE IN L.A. COUNTRY ARE THE U.S. HEADQUARTERS OF NESTLE IN GLENDALE AND FARMER'S INSURANCE IN MIDTOWN, LOS ANGELES. RELATIONS ARE MORE THAN ECONOMIC, AND I'M VERY PLEASED THAT YOU, CHAIRMAN RIDLEY-THOMAS, THAT YOU HAVE MENTIONED ZUMTHOR. I'D LIKE TO ADD THAT WE HAVE AT -- THE WONDERFUL EXHIBITION OF ROSE FISHER WHO HAS WORKED TOGETHER WITH 1500 ANGELINOS TO CREATE AN EXCEPTIONAL EXHIBITION AS A KIND OF FINAL GIFT FOR ME TO HAVE THESE TWO WONDERFUL ARTISTS EXHIBITED HERE IN LOS ANGELES. THE SWISS COMMUNITY IN LOS ANGELES IS VERY SMALL IN COMPARISON TO OTHER COMMUNITIES, BUT CONTRIBUTING THEIR FAIR SHARE TO THE CREATIVE LIFE, TO THE ACADEMIC EXCELLENCE IN L.A. COUNTY AND TO THE ECONOMIC RELATIONSHIP. FOR ME, IT HAS BEEN A HUGE PRIVILEGE AND A GREAT PLEASURE TO SERVE THIS COMMUNITY AND TO CONTRIBUTE TO FURTHER BROADENING AND DEEPENING OF THE EXCELLENT RELATIONSHIP OF SWITZERLAND WITH SOUTHERN CALIFORNIA AND L.A. COUNTY IN PARTICULAR. AND I WOULD LIKE TO THANK THE L.A. COUNTY BOARD OF SUPERVISORS AND ALL THE OFFICIALS OF L.A. COUNTY AND IN PARTICULAR THE OFFICE OF PROTOCOL FOR THE CONTINUED SUPPORT DURING MY STAY HERE IN LOS ANGELES. AND LEAVING LOS ANGELES, I WILL, AS MANY OF MY COLLEAGUES, BECOME KIND OF AN HONORARY AMBASSADOR OF LOS ANGELES AND KEEP TALKING ABOUT OPPORTUNITIES AND ABOUT THE POSSIBILITIES TO FURTHER IMPROVE THE RELATIONSHIP. THANK YOU SO MUCH. [APPLAUSE.] 

SUP. RIDLEY-THOMAS, CHAIRMAN: AS IS OUR ANNUAL CUSTOM, THE 2013 EDUCATIONAL SCHOLARSHIP FOR THE COMMISSION ON DISABILITY, WE ARE PLEASED TO INVITE FORWARD THE PRESIDENT OF THE COMMISSION ON DISABILITIES, JANET NEAL. AND WE ARE HERE TO JUST SIMPLY SAY FOR THE PAST 10 YEARS, THROUGH THE SUCCESS OF THE ACCESS AWARDS LUNCHEON, THE COUNTY OF LOS ANGELES AND THIS COMMISSION ON DISABILITIES HAS AWARDED $1,000 EDUCATIONAL SCHOLARSHIPS TO PROMISING GRADUATING HIGH SCHOOL STUDENTS WITH DISABILITIES FROM EACH SUPERVISORIAL DISTRICT WHO DESIRE THE PURSUIT OF AN EDUCATION BEYOND HIGH SCHOOL. SO IN 2012, THE BOARD OF SUPERVISORS HONORED THE COMMISSION WITH THE FIRST ERNEST T. HAMILTON, JR. MEMORIAL SCHOLARSHIP. TODAY THE BOARD OF SUPERVISORS AGAIN ARE HONORED TO PRESENT CERTIFICATES TO THIS YEAR'S RECIPIENTS. AND FROM THE SECOND DISTRICT, WE'RE PLEASED TO HAVE WITH US OUR HONOREE CAROLINA VASQUEZ. SHE GRADUATED FROM WALLACE EINENBERG HIGH SCHOOL AND PLANS TO PURSUE A BACHELOR'S DEGREE IN MARINE BIOLOGY AND ETHNIC STUDIES AT THE UNIVERSITY OF CALIFORNIA AT SANTA CRUZ. CAROLINA USED HER VOICE TO PROMOTE THE STUDENT ACTIVISTS FOR EQUALITY INITIATIVE AND HELPED TO CREATE A MARKET MAKEOVER TOOLKIT TO PROVIDE HEALTHY EATING CHOICES IN HER COMMUNITY. SHE HAS ALSO SERVED ON NUMEROUS COMMITTEES AND PARTICIPATED IN A RESEARCH CONNECTION PROGRAM WHERE SHE WAS CREDITED WITH CLASSIFYING A NEW WORM SPECIES. I DID SAY SHE WAS INTERESTED IN MARINE BIOLOGY. AND SO WE ARE GLAD TO HAVE HER HERE. WE CELEBRATE HER ACHIEVEMENTS, AND WE CONGRATULATE CAROLINA FOR HER CONTRIBUTIONS TODAY. GIVE HER A ROUND OF APPLAUSE, WON'T YOU? [APPLAUSE.] AND WE ALSO WISH TO ACKNOWLEDGE DARNELL HULCOMB FOR HIS ACHIEVEMENT. AND IN HIS ABSENCE, WE'LL GIVE HIM A ROUND OF APPLAUSE. GIVE DARNELL A ROUND OF APPLAUSE FOR BEING ONE OF OUR HONORED RECIPIENTS, AS WELL. [APPLAUSE.] NOW I WILL TURN THE MIC OVER TO OUR COLLEAGUE, SUPERVISOR GLORIA MOLINA, TO MAKE THE PRESENTATION TO HER RECIPIENT. SUPERVISOR? ALL RIGHT. THEN WE'LL MOVE THEN TO OUR NEXT PRESENTATION, WHO IS FROM THE THIRD DISTRICT, SUPERVISOR ZEV YAROSLAVSKY. 

SUP. YAROSLAVSKY: I'D LIKE TO ASK LONZELL CROMER TO COME FORWARD? HOW ARE YOU? GOOD? LONZELL IS CURRENTLY PURSUING A DEGREE IN BIOLOGY AT PIERCE COLLEGE AND BELIEVES THAT EDUCATION IS HIS VEHICLE TO SELF-SUFFICIENCY AND INDEPENDENCE. HE IS VIEWED AS A HEALTHCARE ADVOCATE BY HIS EMPLOYER AND WAS INSTRUMENTAL IN CREATING MARKETING STRATEGIES WHICH RESULTED IN GENERATING NEW BUSINESS. ALTHOUGH LONZELL WAS TOLD THAT HE WOULD NOT GRADUATE, HE IS ON A PATH TO BECOME A HOLISTIC PEDIATRICIAN AND TO DO SOMETHING IN HIS LIFE THAT HE IS PROUD OF. SO WE ARE HONORED TO HAVE LONZELL HERE TO RECEIVE THIS CERTIFICATE IN HONOR OF THE BILL TAINTER/BERNARD SIEGEL AWARD. CONGRATULATIONS TO YOU. [APPLAUSE.] 

SUP. RIDLEY-THOMAS, CHAIRMAN: SUPERVISOR KNABE, PLEASE. 

SUP. KNABE: LADIES AND GENTLEMEN, IT'S MY PRIVILEGE TO INTRODUCE THIS YEAR'S SCHOLARSHIP RECIPIENT FROM THE FOURTH DISTRICT, IRENE BROWNSEN. IRENE HAS BATTLED BOTH BRAIN CANCER AND A STROKE AND CONTINUES TO SUFFER AND BATTLE THOSE LINGERING EFFECTS. SHE IS CURRENTLY PURSUING HER ASSOCIATE OF SCIENCE DEGREE IN CHILD DEVELOPMENT AT LOS ANGELES HARBOR COLLEGE. DESPITE HER DISABILITY, SHE IS ABLE TO MAINTAIN A G.P.A. OF 3.72, IS A THREE-TIME HONOR STUDENT AND IS ON THE HARBOR COMMUNITY COLLEGE PRESIDENT'S LIST FOR ACADEMIC ACHIEVEMENT. SHE PLANS TO PURSUE A CAREER AS A TEACHER WORKING WITH CHILDREN WITH SPECIAL NEEDS. IN ORDER TO ACCOMPLISH THIS, SHE IS WORKING HARD TO COMPLETE A PROGRAM IN CHILD DEVELOPMENT. SHE IS ALSO PLANNING TO LEARN THE AMERICAN SIGN LANGUAGE TO BROADEN HER SKILLS AND CONTRIBUTIONS EVEN FURTHER. AFTER GRADUATION FROM HARBOR, SHE PLANS TO ENROLL AT CALIFORNIA STATE UNIVERSITY AT DOMINGUEZ HILLS TO OBTAIN BOTH HER BACHELOR'S AND MASTER'S DEGREE. SO AS ONE OF HER PROFESSORS STATED, "I BELIEVE THAT THE COURAGE AND PERSISTENCE THAT IRENE DEMONSTRATES WILL GIVE HER THE FORTITUDE TO ATTAIN THE GOALS THAT SHE HAS SET FOR HERSELF." SO WE HAVE NO DOUBT THAT SHE'S GOING TO SUCCEED, AND I THINK WE'RE ALL CONVINCED THAT STUDENTS LIKE HER JUST WILL BE TRULY BLESSED BY HAVING SOMEONE SPECIAL LIKE IRENE AT THEIR SIDE, CONGRATULATIONS. [APPLAUSE.] 

SUP. RIDLEY-THOMAS, CHAIRMAN: SUPERVISOR ANTONOVICH, PLEASE. 

SUP. ANTONOVICH: MR. CHAIRMAN, MEMBERS, IT'S A PLEASURE TO BRING TO THE BOARD OF SUPERVISORS FOR THE BERNARD SIEGEL/BILL TAINTER MEMORIAL SCHOLARSHIP HAIG BAGADESARIAN, WHO IS A GRADUATE FROM CHARTER OAK HIGH SCHOOL IN COVINA, PLANS TO STUDY BIOLOGY AT THE UNIVERSITY OF CALIFORNIA AT DAVIS IN THE FALL, AND HE WAS INVOLVED IN THE HIGH SCHOOLS IN THE COMMUNITY BY PARTICIPATING IN STUDENT GOVERNMENT, PLAYING ON THE SOCCER TEAM AND IS A MEMBER OF THE BOY SCOUTS SINCE 2009. HE AGREES AND FEELS AND BELIEVES THAT EDUCATION IS THE KEY TO FULFILLING THE DREAMS OF BECOMING A BIOLOGIST AND A PRIVATE HOMEOWNER. SO CONGRATULATIONS HAIG AND WISH YOU CONTINUED SUCCESS. [APPLAUSE.] 

SUP. RIDLEY-THOMAS, CHAIRMAN: THE CHAIR NOW RECOGNIZES SUPERVISOR YAROSLAVSKY FOR HIS PRESENTATION AND SCROLL. JANET NEAL IS HERE TO CLOSE UP THIS PORTION OF THE PRESENTATION ON THE DISABILITIES PRESENTATIONS. 

JANET NEAL: THANK YOU, SUPERVISOR. MY NAME IS JANET NEAL AND I WANT TO THANK THE BOARD OF SUPERVISORS FOR THEIR CONTINUED SUPPORT OF THE COMMISSION. THESE SCHOLARSHIPS PROVIDE FINANCIAL ASSISTANCE TO STUDENTS WITH DISABILITIES TO ENCOURAGE THEM TO TAKE ADVANTAGE OF EXPANDED CAREER OPPORTUNITIES AND HIGHER EDUCATION BEFORE THEM, AND ALSO TO PROMOTE THE CONCEPT THAT THE COMMISSION SUPPORTS, WHICH IS DISABLED DOESN'T MEAN UNABLE. I WOULD ALSO LIKE TO ACKNOWLEDGE COMMISSIONERS MARIA MUSTELIER-PARRISH OF THE SECOND DISTRICT, WINSLOW REITNOUER OF THE FIFTH DISTRICT AND LOUIS BURNS OF ACCESS SERVICES, SANDY EISENBERG OF TOTAL RECALL, DONNA MORGAN OF EDUCATION SERVICES, WHO ARE HERE IN SUPPORT OF THE COMMISSION AND THIS YEAR'S SCHOLARSHIP RECIPIENTS. AND ALSO MR. ROBERT SMITH. THANK YOU VERY MUCH. WE WANT TO CONGRATULATE THE RECIPIENTS AND WISH THEM SUCCESS IN THEIR EDUCATIONAL LIFELONG ENDEAVORS. AND THANK ALL OF YOU FOR COMING AND SUPPORTING THE COMMISSION. [APPLAUSE.] 

SUP. RIDLEY-THOMAS, CHAIRMAN: ANOTHER BIG ROUND OF APPLAUSE FOR THESE SCHOLARSHIP RECIPIENTS. WE WISH THEM WELL ON THEIR JOURNEYS. [APPLAUSE.] NOW SUPERVISOR YAROSLAVSKY, PLEASE. 

SUP. YAROSLAVSKY: MEMBERS OF THE BOARD, WE ARE HONORED TO BE WELCOMED BY MARY LOU WESTERFIELD WHO IS THE REGIONAL DIRECTOR OF ACTORS' EQUITY ASSOCIATION HERE IN SOUTHERN CALIFORNIA. ON MAY 26, 1913, 112 COURAGEOUS ACTORS CONVENED IN A NEW YORK HOTEL WITH THE GOAL OF BANDING TOGETHER TO IMPROVE WORKING CONDITIONS IN THE AMERICAN THEATER, SEEKING NOTHING MORE THAN AN OPPORTUNITY TO PROVE THEIR TALENT AND RECEIVE REASONABLE COMPENSATION FOR THEIR WORK AND BE TREATED WITH DIGNITY AND FAIRNESS WHICH LED TO THE FOUNDING OF THE ACTORS' EQUITY UNION. WHEN PRODUCERS AND MANAGERS REFUSED RECOGNITION OF EQUITY IN 1919, THE MEMBERSHIP MOUNTED A NATIONAL STRIKE THAT LASTED FOR 30 DAYS, ULTIMATELY ACHIEVING A CONTRACT THAT WAS EQUITABLE FOR BOTH SIDES. EQUITY HAS CONSISTENTLY SHOWN COURAGE IN DEFENDING ITS PRINCIPLES, BARRING ITS MEMBERS FROM PERFORMANCE AT THE SEGREGATED NATIONAL THEATER IN WASHINGTON, D.C. UNTIL IT REVERSED ITS DISCRIMINATION POLICIES IN 1947. STANDING FIRM AGAINST THE ODIOUS PRACTICE OF POLITICALLY MOTIVATED BLACK LISTING IN THE 1950S THAT WAS RUINING THE CAREERS OF MANY NOTABLE ACTORS, PLAYWRIGHTS, AND DIRECTORS. EQUITY CHAMPIONED FUNDING FOR THE ARTS AND HELPED SPUR THE ESTABLISHMENT OF THE NATIONAL ENDOWMENT FOR THE ARTS IN THE 1960S. AND MEMBERS LED THE DRIVE TO PRESERVE HISTORIC BROADWAY THEATERS IN THE 1980S, RAISED FUNDING TO STOP THE AIDS EPIDEMIC, AND MOST RECENTLY ADVOCATED FOR NONTRADITIONAL CASTING, AFFORDABLE HOUSING AND HEALTHCARE FOR THE THEATER COMMUNITY AND STRENGTHENED BARGAINING RIGHTS AND MARRIAGE EQUALITY. SO THE BOARD OF SUPERVISORS OF LOS ANGELES COUNTY WANTS TO TAKE THIS OPPORTUNITY TO HONOR THE ACTORS' EQUITY ASSOCIATION AND COMMEND THE ASSOCIATION FOR A CENTURY OF ACHIEVEMENT AND ADVANCEMENT OF THE PERFORM ARTS WITH SINCERE CONGRATULATIONS ON REACHING THIS NOTABLE CENTENNIAL MILESTONE IN ITS HISTORY AND BEST WISHES FOR CONTINUED SUCCESS IN THE FUTURE. SO MARY LOU, THANK YOU, AND TO ALL YOUR MEMBERS, THIS IS FOR THEM. [APPLAUSE.] 

MARY LOU WESTERFIELD: THEATER IS A COLLABORATIVE ART. AND SOME OF THOSE COLLABORATIONS ARE VERY OBVIOUS, THE ACTOR, SINGER, DANCER TO THE DIRECTOR, CHOREOGRAPHER, PLAYWRIGHT. OTHERS ARE LESS OBVIOUS. ACTORS ARE PEOPLE, TOO. WE LIVE IN THE COMMUNITY. WE LIVE IN LOS ANGELES. WE INTERACT WITH OUR BANKS, OUR GROCERS, OUR SUPERVISORS. AND ON BEHALF OF THE 49,000 MEMBERS OF THE ACTORS' EQUITY I WOULD LIKE TO THANK THE L.A. COUNTY BOARD OF SUPERVISORS, AND ZEV IN PARTICULAR FOR THIS LOVELY HONOR AND RECOGNITION OF OUR CENTENNIAL AS WE LOOK FORWARD TO ANOTHER 100 YEARS OF COLLABORATIONS. THANK YOU. [APPLAUSE.] 

SUP. RIDLEY-THOMAS, CHAIRMAN: SUPERVISOR ANTONOVICH, PLEASE. 

SUP. ANTONOVICH: THIS IS A VERY EXCITING PROGRAM THAT I HAD AN OPPORTUNITY TO ATTEND AND PARTICIPATE BY MAKING PROCLAMATIONS AVAILABLE ON BEHALF OF THE COUNTY TO THE SCHOOL, HIGH SCHOOL MONROVIA. SANDY DUFF AND MICHAEL WAGNER HAVE A PROGRAM, A VERY UNIQUE PROGRAM, TO PREVENT TEEN DRUNK DRIVING AT MONROVIA HIGH SCHOOL. IT'S CALLED THROUGH THE "EVERY 15 MINUTE PROGRAM", THROUGH THE EVERY 15 MINUTE PROGRAM. AND THEY HAVE A MOTHER WHO LOST A CHILD IN NORTHERN CALIFORNIA WHO COMES AND PARTICIPATES IN THIS PROGRAM, WHICH WAS CREATED ON A VERY SERIOUS ISSUE THAT IMPACTS NOT JUST OUR HIGH SCHOOLS BUT ALSO OUR JUNIOR AND ELEMENTARY SCHOOLS AND OUR UNIVERSITIES. THINK EVERY 15 MINUTES PROGRAM CHALLENGES TEENS TO THINK ABOUT THE IMPACT OR THE DECISION TO DRINK AND DRIVE WILL HAVE ON THEIR FAMILY, FRIENDS AND OTHERS. VITAL PROGRAMS LIKE THIS ENCOURAGE TEENS TO HAVE A HEALTHY LIFESTYLE, TO BE CONSIDERATE OF OTHERS WHO DO NOT DRINK AND DRIVE. IT IS SUCH A MOVING PROGRAM. THE LOCAL MORTUARY PARTICIPATES IN THIS PROGRAM. THERE IS A CASKET THEY'LL EXPLAIN WHAT THEY DO. BUT IT REALLY MOVES THE STUDENT BODY. AND WHAT'S INTERESTING: SANDY WAS A PERSON WHO GREW UP IN MONROVIA, WENT THROUGH ALL THE SCHOOLS THERE, AND NOW SHE'S TEACHING AND PROVIDING A LEADERSHIP ALONG WITH MICHAEL ON THIS UNIQUE PROGRAM THAT OUGHT TO BE REPLICATED IN EVERY PUBLIC AND PRIVATE SCHOOL IN THE STATE AND NATION. SO ON BEHALF OF THE COUNTY, WE'RE GOING TO GIVE THIS TO SANDY AND TO MICHAEL. AND WE'LL DO THE SCROLL AND THEN YOU CAN DO YOUR LITTLE SPEECH. SHE'S TEACHING. SANDY IS IN THE CLASSROOM, A GOOD TEACHER. NOW, HER COLLEAGUE WHO IS GOING TO SPEAK FOR HER AND HE CAN ALSO GIVE A LITTLE BACKGROUND ON HER BACKGROUND, AND SHE'S NOW THE DEPARTMENT HEAD OF MATHEMATICS? SHE'S THE MATHEMATICS INSTRUCTOR AT MONROVIA HIGH SCHOOL, SO, PLEASE. 

SPEAKER: FIRST OF ALL, WE WANT TO THANK SUPERVISOR ANTONOVICH FOR GIVING US THIS RECOGNITION. SANDY DUFF AND I ARE BOTH TEACHERS AT MONROVIA HIGH SCHOOL. SANDY IS THE DEPARTMENT CHAIR OF MATHEMATICS AND SHE'S ALSO THE DIRECTOR FOR THE A.S.B. FOR THE STUDENT LEADERSHIP. I HAD THE PLEASURE OF BEING THE HEALTH EDUCATION TEACHER. AND SO THAT'S HOW I GOT INVOLVED IN "EVERY 15 MINUTES." EVERY 15 MINUTES IS A DRINKING AND DRIVING PROGRAM WHERE WE ACTUALLY SIMULATE A DRUNK DRIVING ACCIDENT ON OUR CAMPUS. THIS YEAR WE DID IT A LITTLE DIFFERENTLY WHERE WE HAD STUDENTS THAT IN A PRE-FILM, WE SHOWED THEM DRINKING AND COMING BACK TO CLASS. AND THEN WE SIMULATED AN ACCIDENT BY THE PARKING LOT AT THE HIGH SCHOOL. THE MONROVIA POLICE DEPARTMENT, THE FIRE DEPARTMENT COMES IN AND DOES AN ACTUAL SCENE WHERE THEY EXTRICATE STUDENTS FROM THEIR CARS. SOME ARE PRONOUNCED DEAD ON THE SCENE. OTHERS ARE TAKEN TO THE HOSPITAL AND PRONOUNCED DEAD. AND IT'S VERY, VERY REALISTIC. AND THEN WE TAKE ALL THE STUDENTS THAT ARE INVOLVED AND WE TAKE THEM TO A LOCAL HOTEL WHERE THEY STAY ALL NIGHT. AND WE GO THROUGH MANY ACTIVITIES. AND THEN IT CULMINATES WITH AN ASSEMBLY THE NEXT DAY WHERE THE VIDEO IS SHOWN. STUDENTS GET TO READ LETTERS TO THEIR PARENTS AS IF THEY HAD BEEN DEAD. AND IT CAUSES A LOT OF STUDENTS TO THINK TWICE BEFORE THEY DRINK. AGAIN, WE WANT TO THANK YOU VERY MUCH FOR THIS. AND WE WILL BE PUTTING IT ON AGAIN IN 2015. THANK YOU VERY MUCH. [APPLAUSE.] 

SUP. ANTONOVICH: NOW WE HAVE A TWOFER. A DOROTHY AND BETTY PROGRAM. THESE ARE CHIHUAHUA MIXES. BETTY ONE YEAR OLD AND DOROTHY IS THREE. THIS IS A MOTHER-DAUGHTER COMBO. NOW, AS WE SUPPORT TRADITIONAL VALUES, WE WANT TO KEEP THEM TOGETHER. SO ANYBODY WHO WOULD LIKE TO ADOPT A MOTHER AND DAUGHTER, 562-728- 4610, YOU CAN GET TWO WONDERFUL LITTLE CHIHUAHUA MIXES WHO WILL GIVE YOU A LOT OF LOVE AND COMFORT. 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU, SUPERVISOR ANTONOVICH. MADAM EXECUTIVE OFFICER, YOU HAVE AN ANNOUNCEMENT. 

SACHI HAMAI, EXEC. OFFICER: YES, MR. CHAIRMAN. IT WAS BROUGHT TO OUR ATTENTION THAT THERE IS A WHITE CAR OUT IN LOT 22 THAT THEY'VE LEFT THEIR DOG IN THE CAR AND THE WINDOWS ARE BARELY CRACKED. IT'S A LITTLE BIT WARM OUT THERE. SO ANYBODY HAS A WHITE CAR IN LOT 22 WITH A DOG IN IT, YOU MAY WANT TO GO CHECK ON IT. THANK YOU. 

SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. PLEASE, IF YOU'VE HEARD THAT ANNOUNCEMENT AND YOU ARE PARKED IN LOT 22, WE'D ENCOURAGE YOU TO MOVE SWIFTLY AS YOU CAN TO AVOID ANY UNFORTUNATE INCIDENTS. THE CHAIR RECOGNIZES SUPERVISOR YAROSLAVSKY. 

SUP. YAROSLAVSKY: MR. CHAIRMAN, THANK YOU FOR TAKING ME OUT OF ORDER BRIEFLY. I'D LIKE TO ASK DEAN LOGAN, OUR COUNTY REGISTRAR, I DON'T KNOW IF HE'S STILL HERE. HERE HE COMES. I'D LIKE TO JUST ASK HIM TO MAKE A BRIEF DESCRIPTION OF THE PLANS THAT ARE BEING IMPLEMENTED BY THE REGISTRAR-RECORDER'S OFFICE IN LIGHT OF THE SUPREME COURT DECISION LAST WEEK ON SAME-SEX MARRIAGES. SO, DEAN, IF YOU WOULD JUST TAKE A MOMENT. 

DEAN LOGAN: SURE. GOOD MORNING, SUPERVISORS. I'M PLEASED TO REPORT THAT WE GOT WORD LATE FRIDAY AFTERNOON THAT THE STAY HAD BEEN LIFTED BY THE NINTH CIRCUIT COURT OF APPEALS AND THAT WE WERE DIRECTED BY THE DEPARTMENT OF PUBLIC HEALTH TO RESUME ISSUING MARRIAGE LICENSES AND OFFERING CIVIL MARRIAGE CEREMONIES TO SAME-SEX COUPLES IN CALIFORNIA. WE WORKED OVER THE WEEKEND, AND WE HAD ALREADY HAD A CONTINGENCY PLAN IN PLACE TO DEAL WITH THE INCREASED ACTIVITY. WE PUT THAT INTO PLACE YESTERDAY. IT WAS A VERY SUCCESSFUL DAY, A LOT OF ACTIVITY. WE ISSUED OVER 621 LICENSES YESTERDAY, PERFORMED OVER 100 CIVIL CEREMONIES IN OUR OFFICES IN NORWALK. IN ADDITION TO THAT, WE HAVE PARTNERED WITH THE CITY OF WEST HOLLYWOOD AND THE CITY OF LONG BEACH TO OFFER PRE-SCHEDULED, PREPAID CIVIL CEREMONIES TO AGAIN COMPENSATE FOR THE INCREASED ACTIVITY DURING WHAT IS ALREADY THE PEAK MARRIAGE SEASON IN LOS ANGELES COUNTY. SO EVERYTHING WENT SMOOTHLY YESTERDAY. I THINK WE HAD POSITIVE FEEDBACK FROM THE COMMUNITY. OUR FACILITIES WERE ABLE TO HANDLE THE ADDITIONAL ACTIVITY WITHOUT DISRUPTING OTHER SERVICES. FROM OUR PERSPECTIVE AT THIS POINT, THEY MAY BE SPECIAL -- THEY ARE NO LONGER SPECIAL SERVICES, THEY'RE PUBLIC SERVICES. WE ARE RESPONDING IN KIND AND ALL THINGS SEEM TO BE GOING WELL. 

SUP. YAROSLAVSKY: THANK YOU. THANK YOU, DEAN. 

SUP. ANTONOVICH: WHAT IS THE ADDITIONAL COST THAT WILL IMPACT YOUR DEPARTMENT? 

DEAN LOGAN: THERE REALLY SHOULD BE MINIMAL ADDITIONAL COST. WE DID REMAIN OPEN UNTIL 7 P.M. YESTERDAY AND WE WILL AGAIN TONIGHT, SO THERE WILL BE SOME MINIMAL OVERTIME COSTS ASSOCIATED WITH THAT. I THINK THOSE WILL PROBABLY BE FAR OFFSET BY THE INCREASE IN THE NUMBER OF LICENSES ISSUED AND THE FEES ASSOCIATED WITH THAT. THERE IS NO COST TO THE PARTNERSHIPS WITH WEST HOLLYWOOD AND LONG BEACH. THEY'RE DOING THOSE, PROVIDING THOSE SERVICES ON A VOLUNTARY BASIS. SO ALL OF THE SYSTEMATIC CHANGES THAT HAD TO TAKE PLACE ACTUALLY ALREADY TOOK PLACE IN 2008 DURING THE BRIEF PERIOD OF TIME WHEN THE LAW WAS IN EFFECT. SO THERE WERE NO SYSTEM CHANGES THAT HAD TO BE MADE AT THIS POINT. 

SUP. ANTONOVICH: LET US KNOW WHAT THE COST IS. 

DEAN LOGAN: YEAH. 

SUP. YAROSLAVSKY: MR. CHAIRMAN, I JUST WANTED TO THANK DEAN AND HIS STAFF FOR BEING ON TOP OF THIS, BOTH BACK IN 2008 WHEN IT WAS THE FIRST TIME AND TO BE READY THIS TIME. U.C.L.A. FOOTBALL COACH, FORMER COACH BOB TOLEDO USED TO RUN AN EXERCISE DURING HIS PRACTICES CALLED SUDDEN CHANGE WHERE HE WOULD IN THE MIDDLE OF THE PRACTICE JUST BLOW THE WHISTLE AND YELL "SUDDEN CHANGE" TO REPLICATE A TURNOVER OR SOMETHING LIKE THAT. WE IN GOVERNMENT GET IN REAL LIFE TO GO THROUGH SUDDEN CHANGE ABOUT ONCE OR TWICE A DAY. BUT THIS IS A REAL SUDDEN CHANGE FOR THE REGISTRAR-RECORDER'S OFFICE AND YOU FOLKS HAVE DONE A GREAT JOB AND I KNOW THE COMMUNITY APPRECIATES IT AND WE DO, TOO. THANK YOU, DEAN. 

DEAN LOGAN: THANK YOU. 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU VERY MUCH, SUPERVISOR. AND MR. LOGAN, WE THANK YOU FOR YOUR REPORT AND WE LOOK FORWARD TO FUTURE REPORTS OF THE DEPARTMENT. MADAM EXECUTIVE OFFICER? 

SACHI HAMAI, EXEC. OFFICER: MR. CHAIRMAN, I BELIEVE THAT THERE IS A NUMBER OF SPEAKERS THAT HAVE HELD SEVERAL ITEMS? 

SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. THEY ARE BEFORE US, THEN. WE BEGIN WITH PATRICK MULCAHEY, GENEVIEVE CLAVREUL. I'M SORRY, PATRICIA MULCAHEY, GENEVIEVE CLAVREUL, ARNOLD SACHS, ERIC PREVEN, LORI MARTIN, BRUCE HECKER, IF YOU WOULD COME FORWARD, WE'D BE GLAD TO HEAR FROM YOU NOW. 

ERIC PREVEN: SHOULD I PROCEED? 

SUP. RIDLEY-THOMAS, CHAIRMAN: YOU MAY. 

ERIC PREVEN: YES, IT'S ERIC PREVEN COUNTY RESIDENT FROM DISTRICT 3. GOOD MORNING, BOARD OF SUPERVISORS. AND THANK YOU, SUPERVISOR YAROSLAVSKY, FOR RECOGNIZING MR. LOGAN AND HOW EXCITING IT IS THAT SAME-SEX MARRIAGE CAN NOW HAPPEN IN OUR COUNTY. I ALSO WANT TO GIVE A SHOUT OUT TO REED ELSIVERE, THE COMPANY THAT HAS A VERY GOOD DEAL WITH THE COUNTY FOR PRINTING OUT VARIOUS CERTIFICATES FOR US. THAT IS A GOOD DAY FOR THEM IF THERE IS SOME UP-TICK THERE. S.-1, WHICH I'M NOT GOING TO SPEAK ABOUT BECAUSE I'M ADVISED REGULARLY IT'S BEEN CONTINUED AND I'M WASTING MY TIME. BUT IT'S BEEN CONTINUED SO MANY TIMES. IT HAS TO DO WITH OUR CAPITAL PROJECTS. I JUST FEEL THAT CAPITAL PROJECTS, WHICH ARE BIG DECISIONS, SHOULD BE MAXIMALLY VENTILATED IN FRONT OF THE PUBLIC AND TRANSPARENT. SO THE ABSENCE OF THIS, AND I NOTE ITEM 3 ALSO, WHICH IS SORT OF LINKED TO THAT BECAUSE IT'S A LOCAL HIRING POLICY THAT'S CONTINGENT ON WHAT IT IS WE'RE DOING, WE KNOW THAT YOU ARE PLANNING A JAIL HOSPITAL, PERHAPS, OR SOME OTHER THINGS, OR MAYBE A REDO OF THIS BUILDING, BUT WE WANT TO KNOW SPECIFICALLY WHAT'S HAPPENING AMONG ALL THE CHARACTERS OVER HERE. ITEM 1 REQUIRES NOT JUST RESIDENT CURIOSITY BUT APPARENTLY SUPERVISORIAL CURIOSITY, TOO. BECAUSE WE SEEM TO BE FACING IN OUR REDEVELOPMENT DISSOLUTION OVERSIGHT CATEGORY THE PUSHING THROUGH OF A GUY WHO IS SQUARELY IN CONFLICT BY CATEGORY. HE SITS ON THE CITY'S FINANCE COMMITTEE DOWN IN RANCHOS PALOS VERDES, WHICH IS A BIG USER OF THE SHERIFF'S DEPARTMENT, BY THE WAY, THEY ARE THE LARGEST SINGLE PART OF THE GENERAL FUND FOR THAT CITY GOES TO OUR SHERIFF. AND IN REWARD FOR ALL THAT SERVICE HE'S INCREASING THE FEE 2-1/2 PERCENT THIS YEAR I LEARNED. BUT THE POINT IS, IS THAT MR. O'BRIEN WHO IS A FORMER JUDGE AND A REASONABLE MAN CERTAINLY AND VERY KNOWLEDGEABLE GUY, THOUGH YOU CAN FIND SOME INFORMATION THAT HE WROTE UNDER HIS OWN NAME THAT IS CONTROVERSIAL, WHY WOULD WE BE GOING AGAINST THE RULES THAT WE'VE SET UP? THERE ARE SO MANY FRESH EYES, SO MANY PEOPLE WHO CAN DO THIS PARTICULAR FUNCTION. I WOULD ASK THE SUPERVISORS TO LOOK CLOSELY AT THAT AND SEE IF WE CAN'T FIND SOMEONE WHO IS MORE APPROPRIATE FOR THAT. ITEM NO. 9 IS MAYOR ANTONOVICH'S TWO SUGGESTIONS FOR THE BLUE RIBBON COMMISSION ON THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES. THOSE TWO INDIVIDUALS, ONE OF THEM YOU'LL RECOGNIZE IS DICKRAN TEVRIZIAN, WHO IS A FORMER JUDGE WHO SERVED ON THE CITIZENS COMMISSION ON JAIL VIOLENCE, WHICH IS STILL LOOKING FOR INSPECTOR GENERAL ALMOST 10 MONTHS LATER. YET FOR THIS BLUE RIBBON COMMISSION, THE SUGGESTION WAS JULY 1 WE WOULD HAVE EVERYBODY IN PLACE. OBVIOUSLY THAT'S NOT GOING TO WORK. BUT I'M VERY CONFUSED BY THE TIMING ON THAT, I MUST SAY. ITEM NO. 11, I'LL MAKE THIS VERY BRIEF, IS SOME ARTS COMMISSION MONEY. I JUST WISH, IT'S SO SMALL, IT'S 4 MILLION FOR A BUNCH OF ORGANIZATIONS, ALMOST 200 ORGANIZATIONS, AND YET WE'RE GOING TO BE SPENDING WHAT SEEMS TO BE I THINK I READ ALMOST $70 MILLION UPGRADING THE JOHN ANSON FORD THEATER. IF THAT'S A CAPITAL PROJECT, I DON'T KNOW, I HAVEN'T SEEN MUCH ON IT. I'VE SEEN A BUDGET. ITEM 15, I DO SORT OF SUPPORT. THIS IS AN INTERNATIONAL GROUP. THEY ONLY MADE 40,000 FROM THE COUNTY. I'M SURE THEY RAISED SOME UNDER THE 501 (C)-3 DIMENSION. 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU, MR. PREVEN, YOUR TIME HAS EXPIRED. THANK YOU. 

ERIC PREVEN: ALL RIGHT WELL THEN THANK YOU FOR YOUR TIME. 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU. NEXT SPEAKER, PLEASE. 

DR. GENEVIEVE CLAVRUEL: DR. GENEVIEVE CLAVREUL, GOOD MORNING. 

SUP. RIDLEY-THOMAS, CHAIRMAN: GOOD MORNING. 

DR. GENEVIEVE CLAVREUL: ON ITEM 1, HAVE BEEN CONTINUED ON THE COMMISSION ON H.I.V., THERE IS 16 NAMES AND ALL THOSE 16 NAMES ARE NOT UNAFFILIATED. THEY ALL EITHER PROVIDE CARE FOR H.I.V. OR RECEIVE CARE FOR H.I.V., WHICH IS, YOU KNOW, THEY NEED TO HAVE A PORTION WHO IS NOT USER, BUT THAT HAS NOT CHANGED FOR THE LAST FEW YEARS AND YOU CONTINUE TO APPROVE IT. ON ITEM 9 AND 68 WERE ABOUT THE BLUE RIBBON COMMISSION. I WAS NOT SURPRISED BY THE APPOINTMENT. I DON'T THINK WE'LL SEE THAT MUCH OF A CHANGE. I ALSO THINK THAT THE TIME IS VERY SHORT TO HAVE THAT COMMISSION PUT TOGETHER. AND THE LENGTH OF TIME, SIX MONTHS, IS VERY SHORT. ON ITEM 23, IT'S STILL ABOUT SOLE VENDOR CONTRACT. I'M STILL SUPER ALLERGIC TO IT. I'M NOT GOING TO CHANGE. ON ITEM 25, THAT'S PRETTY SCARY. THAT'S AN ITEM HAVING TO DO WITH THE DEPARTMENT OF PUBLIC HEALTH. AND THE AMOUNTS ARE QUITE SUBSTANTIAL. AND GUESS WHAT? THEY HAVE THAT LITTLE LINE SAYING THAT THEY CAN INCREASE OR DECREASE BY 25 PERCENT WITHOUT COMING BACK TO THE BOARD. WELL, 25 PERCENT TO 106 MILLION SOMETHING IS 26 MILLION, ALMOST 27 MILLION. PRETTY STEEP NOT TO HAVE TO COME BACK TO THE BOARD. I DON'T KNOW ABOUT YOU, BUT THAT'S SCARED ME. AND IF WE TALK ABOUT THE FOUR YEARS THAT THE CONTRACT CALLED FOR, 25 PERCENT OF 466 MILLION IS 116 MILLION. AND FOR THOSE CONTRACTS NOT TO HAVE TO COME BACK TO THE BOARD AND BE ABLE TO INCREASE IS ASININE. I MEAN, IT'S JUST UNBELIEVABLE THAT YOU ALLOW THAT. AND ON ITEM 58 S.E.A., HAVING TO DO WITH THE AFFORDABLE CARE ACT, YOU KNOW, I'M GETTING TIRED OF HAVING ALL THOSE THINGS HAVING TO DO WITH S.E.A. NOT COMING TO THE BOARD. THERE IS NO REPORT. THERE IS NO INFORMATION. WE HAVE BEEN, YOU KNOW, SOME VERY NOT CUTESY SLIDE CAME ACROSS. ALSO, YOU KNOW, DR. KATZ FORGOT TO TELL US THAT ACTUALLY, YOU KNOW, UNITED HEALTH, WHO REPRESENT A.A.R.P. HAVE DECIDED TO LEAVE THE STATE OF CALIFORNIA AND NOT BE INVOLVED IN ANY INSURANCE FOR PRIVATE PATIENTS, THE SAME AS A.E.T.N.A. SO I THINK THOSE ARE VERY INFORMATION, I THINK WE SHOULD KNOW ABOUT IT AND I THINK WE SHOULD BE KEPT UP. AND ALSO, I THINK, THE NEXT TIME DR. KATZ COMES IN WITH A PROPOSAL ABOUT E.H.R., HE SHARES WITH YOU WHICH ONE OF THE BEST AND THE WORST. THANK YOU. NEXT SPEAKER PLEASE. 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU. NEXT SPEAKER, PLEASE. 

LORI MARTIN: MY NAME IS LORI MARTIN I RESIDE IN RIVERSIDE COUNTY. I SUBMITTED TO THE BOARD EXECUTIVE OFFICE I BELIEVE YESTERDAY SOMETIME A PUBLIC RECOMMENDATION FOR IMPLEMENTATION OF CHANGE TO THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES. IT WAS FIVE RECOMMENDATIONS, TRANSPARENCY ISSUES FOR ANONYMOUS REPORTING NEEDS TO BE DONE AWAY WITH UNLESS A MANDATED REPORTER. IF YOU ARE PROSECUTING PARTIES WHO ARE PLACING FALSE CALLS, LESS LIKELY TO RECEIVE THESE FALSE CALLS. NUMBER 2, REFER TO NUMBER 1. THE SOCIAL WORKERS COMPLAIN ABOUT CASELOADS. IF THEY WERE ACTUALLY INVESTIGATING ABUSE AND NEGLECT AS OPPOSED TO FALSE REPORTS THAT ARE COMING IN BY MALICIOUS PARTIES, THIS WOULD HELP THEIR CASELOAD. EXCUSE ME, DO YOU MIND? CAN YOU STOP MY CLOCK FOR A SECOND? 

SUP. RIDLEY-THOMAS, CHAIRMAN: MA'AM? 

LORI MARTIN: IT'S FINE, I KNOW WHAT I'M DOING HERE. ALL RIGHT. OKAY. NUMBER 3 IS THE TRAINING ISSUES. I'VE REQUESTED SEVERAL TIMES THAT YOU LOOK INTO PROPER TRAINING ISSUES. I THINK I YOU NEED TO START THE CLOCK AGAIN, PLEASE. THERE'S THE BOARD OF BEHAVIORAL SCIENCES, THE BOARD OF PSYCHOLOGY ACTUALLY HAS ADMINISTRATIVE HEARINGS CONTAINS A LAW ENFORCEMENT AGENT IF A PARTY IS FOUND GUILTY OF COMMITTING A CRIME THEY ARE ARRESTED AND CHARGED UPON THE ENDING OF THE ADMINISTRATIVE HEARING. WE NEED TO START DOING THIS WITH THE SOCIAL WORKERS. AND I HAVE PROOF OF FRAUD RIGHT HERE. I RECEIVED THIS ON 6/18 FROM SHARON CEDILLA, ONE OF YOUR COUNTY WORKERS. AND SHE ACTUALLY NOT ONLY DEFRAUDED ME, SHE DEFRAUDED PACIFIC TOXICOLOGY. AND I'M ALSO AWARE THAT THE CONTRACT WITH PACIFIC TOXICOLOGY HAS BEEN TERMINATED. I DON'T KNOW WHY SHE'S SENDING ME A LETTER STATING THAT I HAVE TO GO TOXICOLOGY TEST AT A CORPORATION THAT NO LONGER COOPERATES WITH L.A. COUNTY. NOT ONLY THAT, ON ANY OF THESE MINUTE ORDERS THAT I CONTAIN IN MY HAND FROM VARIOUS HEARINGS, FROM VARIOUS JUDGES, NOT ONCE HAVE I BEEN ORDERED TO TOXICOLOGY TEST. THIS DOCUMENT IS FRAUD. THIS IS THE TYPE OF ACTIVITY THAT IS DAMAGING L.A. IT IS ALSO DAMAGING THE CORPORATIONS RELATIONSHIPS WITH PACIFIC TOXICOLOGY. I SPOKE WITH JEFF LONZOLATTA ON THE 26TH. HE REQUESTED A WRITTEN FORMAL COMPLAINT TO HIM THAT HIS CORPORATION WAS DEFRAUDED AND I'VE ALSO REQUESTED THAT HE PRESS CHARGES. OBVIOUSLY AS A MEMBER OF THE PUBLIC, I CANNOT PRESS CHARGES, BUT A COLLABORATIVE COOPERATION THAT WAS CONTRACTED WITH L.A. COUNTY SURE CAN. THIS IS THE TYPE OF ACTIVITY THAT NEEDS TO STOP. THIS IS MAKING YOUR BOARD LOOK HORRIBLE, CHILDREN SERVICES LOOK HORRIBLE, AND IT'S VICTIMIZING PARTIES LIKE MYSELF. I HAVE JUMPED THROUGH THE HOOPS OF D.C.S.F. I HAVE BEEN CALLED A DEVOTED PARENT IN 2004 BY ONE OF THE WORKERS. WHY THIS WAS OMITTED FROM THE REPORTS THAT ARE BEING USED CURRENTLY I HAVE NO CLUE OTHER THAN THE FACT THAT I HAD FILED A COMPLAINT THREE MONTHS PRIOR TO THE DETAINMENT OF MY CHILD. I HAVE REQUESTED NUMEROUS TIMES FOR THE FILING FOR MY CASE TO BE DISMISSED. IS THIS BOARD REALLY GOING TO FIX IT? PLEASE, TAKE MY RECOMMENDATIONS INTO CONSIDERATION. I ALSO AM ASKING FOR NONUNIONIZED WORKERS. I LIVE IN RIVERSIDE COUNTY. THEY ACTED ILLEGALLY EVEN COMING INTO MY COUNTY TO BEGIN WITH BECAUSE NO CHILD WAS AT MY RESIDENCE WHEN THEY ENTERED. 

SUP. ANTONOVICH: WHERE DID YOU LIVE PRIOR TO RIVERSIDE COUNTY? 

LORI MARTIN: I HAD RESIDED IN ANGELES COUNTY. 

SUP. ANTONOVICH: WHICH SUPERVISORIAL DISTRICT? 

LORI MARTIN: I'VE LIVED VARIOUS PLACES, SIR. I AM A FORMER WARD OF THE COURT. I'VE LIVED MANY PLACES, APPROXIMATELY 50 DIFFERENT RESIDENCES AND MOST OF THEM WERE IN L.A. COUNTY, KERN COUNTY, VENTURA COUNTY, RIVERSIDE COUNTY AND I EVEN LIVED IN THE U.K. FOR A WHILE. I HAVEN'T RESIDED IN L.A. COUNTY FOR MORE THAN THREE YEARS. 

SUP. RIDLEY-THOMAS, CHAIRMAN: WE THANK YOU FOR YOUR TESTIMONY. VERY MUCH. NEXT SPEAKER, PLEASE. 

PATRICIA MULCAHEY: OKAY. ONCE AGAIN YOU'RE GOING AGAINST THE BROWN ACT. NOW, THOSE ARE RIGHTS, THE AMENDMENTS, THE AMENDMENTS THAT YOU GUYS ARE BREAKING AND OUR GOVERNMENT OFFICIALS UP IN WASHINGTON, D.C. "GOVERNMENT SHALL MAKE NO LAW IN RESPECT RELIGION -- FREE EXERCISE THEREOF, THE PROVISION OF THE FREEDOM SPEECH OR THE PRESS OR THE RIGHT OF THE PEOPLE TO ASSEMBLE PEACEFULLY AND TO PETITION THE GOVERNMENT FOR REDRESS OF GRIEVANCES." THAT WOULD BE -- THIS WOULD BE THE LAW THING. BRADY VERSUS MARYLAND, 1969. NOW IN REFERENCE TO BEING A WHISTLE BLOWER, SEPTEMBER 4, 2001, WHEN I MET WITH AUDIT MANAGER. WE HAD A DOCTOR FROM KAISER NAMED DR. ROBERT STONE STATED HE SAW NO EVIDENCE OR SIGN OF ABUSE IN REGARDS TO OUR FAMILY THAT BY GOD YOU HAVE SOCIAL WORKERS THAT COMMIT PERJURY, BECAUSE OF THE HOUSE BILL CALLED S511. YOU ALSO, IN REGARDS TO QUEENS OF ANGELS. QUEENS OF ANGELS HOSPITAL. THE HOSPITAL OFFICIALS ALL GOT BUSTED FOR MEDICAID AND MEDICAL FRAUD. WELL I DID MORE INVESTIGATION WORK. I HAD MY CHILD WAS TAKEN THERE. I HAD MY CHILD THAT I GAVE BIRTH TO, MY KID IN QUEENS OF ANGELS. MY CHILD WAS TAKEN AWAY. -- PARENTS, YES, I WAS. I DID A LOT, OKAY? I DID A LOT OF INVESTIGATION WORK. WHEN YOU TARGET FAMILIES TO REMOVE KIDS AND WITH HOSPITAL OFFICIALS IN REGARDS TO QUEENS OF ANGELS THAT'S CIVIL RIGHTS VIOLATION. NOW THEY HEARD A CASE IN GOLDEN GATE COURT WITH REGARDS TO FOSTER WARDS AND JUVENILE DELINQUENTS BEING FORCE FED PSYCHO -- DRUGS. THAT'S ANOTHER CIVIL RIGHTS VIOLATION. NOW, WHEN ARE WE GOING TO ADDRESS THIS? NOW, ANY VETERANS OUT THERE THAT CAN HAVE PROBLEMS FINDING A HOMES, I WOULD GIVE YOU MY UNCLE'S NUMBER, WHICH I'M PROBABLY NOT GOING TO GIVE YOU, BUT 240-379-7840, ALSO, IN REGARDS TO DIANE.ROWLAND@MACKPACK REGARDS TO KAISER AND UNINSURED ALSO GETS YOU TO THE BILLS THAT'S BEING PASSED IN CONGRESS IN REGARDS TO THE OBAMA CARE. I DON'T KNOW IF YOU UNDERSTAND THIS, BUT MOLINA, YOU SPOKE A WHILE BACK IN REGARDS TO NOT WRITING THE ARMS LETTERS FOR THE I.E.P.S THAT THEY WERE SUPPOSED TO BE DONE, NOW I HAD THE SOCIAL WORKERS SAY TO MY FACE THAT THEY LISTED MY YOUNGER DAUGHTER WITH THE REGIONAL CENTER FOR THE HIGHER FEDERAL RATE. YOU WANT TO PUT DOWN YOUR WATERMELON AND LISTEN TO ME? OKAY, NOW, THIS IS SERIOUS. YOU MENTIONED THIS BEFORE YOU WOULD LOOK INTO THIS, OKAY? CLASSIFYING KIDS AS RETARDED THAT WERE CLEARLY NOT RETARDED FOR THE HIGHER FEDERAL RATE. DID YOU LOOK INTO THIS? OF COURSE YOU DID NOT. ALL RIGHT. NOW, IN REGARDS TO BEING A WHISTLE BLOWER, THEY ALWAYS GET YOU KNOW WHAT? SCREWED ALL OVER, OKAY? IF IT WAS ME AND F.B.I. AGENT KEITH COLE, THAT WAS THE ONLY REASON MY KIDS WERE REMOVED FROM BEVERLY BANK'S HOUSE. AND THEY DID A BIG WRITE-UP ABOUT THAT -- MILLER IN REGARDS TO L.A. WEEKLY. AND I'M STILL WAITING FOR YOU TO ADDRESS MY GRIEVANCES. THAT DOESN'T HAPPEN. I GUESS THAT MAYBE THE ONLY OPTION WE HAVE LEFT IS CLASS ACTION LAWSUIT. MY WEBSITE IS PATRICIA.MULCAHEY @YAHOO.COM. 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU, YOUR TIME HAS EXPIRED. NEXT SPEAKER, PLEASE. 

ARNOLD SACHS: GOOD MORNING. ARNOLD SACHS. A FEW ITEMS THAT I HELD, AGAIN, I HELD ITEM NO. 1. THE COUNTY SHOULD NOT APPOINT CITY-AFFILIATED INDIVIDUALS AS A POLICY, B.F.D. BUT YOU HAVE APPOINTED SO MANY OVERSIGHT BOARDS FOR REDEVELOPMENT, WHEN DO YOU GET A REPORT BACK? BECAUSE YOU ARE THE AGENCY THAT'S APPOINTING THESE OVERSIGHT BOARDS. WHEN DO YOU GET REPORTS BACK ON WHAT THE REDEVELOPMENT AGENCIES ARE ACCOMPLISHING AND DOING WITH THE REDEVELOPMENT PROPERTY AND/OR MONEY THAT THE CITIES HAD? YOUR QUALIFIED WORKERS PROGRAM, MR. SUPERVISOR RIDLEY-THOMAS, FIRST PREFERENCE IS L.A. ZIP CODES WITHIN A FIVE-MILE RADIUS, WHICH IS APPROXIMATELY 78.5 MILES. YOU CAN DO THE MATH. THAT'S 3 PI R SQUARED. AND YOUR SECOND PREFERENCE IS UNEMPLOYMENT IN EXCESS OF THREE TIMES THE COUNTY RATE AS A WHOLE. DON'T YOU THINK THE PREFERENCES SHOULD BE CHANGED AROUND? YOU HAVE A HIGHER UNEMPLOYMENT RATE, THEY SHOULD HAVE FIRST PREFERENCE ON THE JOB AS LONG AS BOTH SETS OF WORKERS ARE QUALIFIED. NOW YOUR BLUE RIBBON COMMISSION. NOW, I CERTAINLY DON'T HAVE THE BINDER THAT SUPERVISOR YAROSLAVSKY HAD, AND I CERTAINLY DON'T HAVE 859 RECOMMENDATIONS THAT SUPERVISOR KNABE HAD, BY THE WAY, HOW MANY OF THOSE RECOMMENDATIONS AND/OR FROM THAT BINDER HAVE YOU ENACTED FOR D.C.F.S.? BECAUSE YOU SPENT A LOT OF MONEY CREATING ALL THOSE RECOMMENDATIONS IN THAT BINDER, HOW MANY HAVE BEEN ENACTED BY D.C.F.S. BEFORE THIS BLUE RIBBON PANEL IS BEING IMPANELED? I DON'T HEAR A BIG ANSWER. I'M THINKING ZERO. THEN WE HAVE FROM 2011, THE TURN-AROUND EXPERT. THIS IS ANTONIO JIMENEZ. AND SHE'S A TURNAROUND EXPERT. AND THEN IN 2012, WE BROUGHT PHILIP BROWNING IN. HE'S A TURNAROUND ARTIST. THAT'S WHAT SUPERVISOR YAROSLAVSKY SAID. THAT'S FROM MARCH 30. AND THEN SHE QUIT BECAUSE SHE OPPOSED THE PROVISION IN THE CONTRACT THAT BARRED HER FROM SHARING THE INVESTIGATIVE UNIT REPORTS WITH THE STAFF AT D.C.F.S. IN 2011. THAT GOES BACK TO -- IT GOES BACK ACTUALLY TO 1991. IN 1995 YOU TAPPED TILTON DURFEE TO TO PUSH FOR CHANGE IN SACRAMENTO. NEXT YEAR, LEGISLATION WOULD BE CHANGED TO ALLOW FOR SHARING. BUT THE BEST THING ABOUT THIS -- AND THIS GOES TO SUPERVISOR MOLINA -- WITH ALL THESE REPORTS, THIS IS INPUT. THIS IS INPUT INFORMATION. AS SUPERVISOR MOLINA SO VIVIDLY ANNOUNCED, THAT'S JUST A HAND JOB. AND SO THOSE 859 IN THAT BINDER, YOU SHOULD PAY ATTENTION, THAT'S THE BIGGEST, ONE OF THE BIGGEST HAND JOBS THAT THE COUNTY'S EVER MADE. AND BY THE WAY, SUPERVISOR, VERY QUICKLY BEAR WITH ME. 

SUP. RIDLEY-THOMAS, CHAIRMAN: YOUR TIME HAS EXPIRED. 

ARNOLD SACHS: BEAR WITH ME. 

SUP. RIDLEY-THOMAS, CHAIRMAN: YOUR TIME HAS EXPIRED. ALL RIGHT. ARNOLD? THANK YOU. LET'S PROCEED TO THE BALANCE OF THE AGENDA. MADAM EXECUTIVE OFFICER. 

SACHI HAMAI, EXEC. OFFICER: THE FOLLOWING ITEMS ARE BEFORE YOU. ON ITEM NO. S-1, THAT WILL BE CONTINUED TO JULY 30TH. ITEM NO. 1-D WILL BE BEFORE YOU. ITEM NO. 1, SUPERVISOR ANTONOVICH AGAIN VOTES NO ON THE APPOINTMENT OF GREGORY O'BRIEN. AND ALSO ON ITEM NO. 1, SUPERVISOR YAROSLAVSKY REQUESTS THAT THE APPOINTMENTS BY THE COMMISSION ON H.I.V. BE CONTINUED ONE WEEK. THE REMAINING ITEMS UNDER THE ITEM NO. 1 WILL BE BEFORE YOU. ITEM NO. 3 WILL BE CONTINUED TWO WEEKS. ITEM NO. 9 WILL BE BEFORE YOU. ITEM NO. 11. ALSO ON ITEM NO. 15, THAT ITEM IS BEFORE YOU. SUPERVISOR ANTONOVICH WILL BE RELEASING HIS HOLD ON IT. ITEM NO. 17 IS BEFORE YOU, 18, 19, 22, 23 AND 24 WILL BE CONTINUED TWO WEEKS. ITEM NO. 25 WILL BE BEFORE YOU, 34, 35. ITEM NO. 40 WILL BE CONTINUED ONE WEEK. 41 WILL BE BEFORE YOU. 44 WILL BE TAKEN OFF CALENDAR. 47 IS BEFORE YOU. 54 IS BEFORE YOU. 55 AND 56 WILL BE BEFORE YOU. AND THEN ITEM NO. 58 WILL BE CONTINUED THREE WEEKS. AND ITEM NO. 60-A IS BEFORE YOU. 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU VERY MUCH. YOU'VE HEARD THE READING OF THE ITEMS BEFORE US. MEMBERS OF THE BOARD, SUPERVISOR KNABE MOVES, SUPERVISOR MOLINA SECONDS. SEEING NO OBJECTIONS, THAT WILL BE THE ORDER. NOW WE WILL MOVE TO THE NEXT ITEM BEFORE US WHICH IS TO HAVE A PUBLIC HEARING ITEM WHICH IS ITEM NO. 59. THOSE WHO HAVE INDICATED THAT THEY WISH TO BE HEARD ON ITEM NO. 59, THIS IS YOUR TIME TO BE ACKNOWLEDGED. I'LL TAKE THOSE. 

SACHI HAMAI, EXEC. OFFICER: AND IF I CAN, MR. CHAIRMAN, SWEAR EVERYBODY IN ON THIS ITEM. 

SUP. RIDLEY-THOMAS, CHAIRMAN: PLEASE PROCEED. 

SACHI HAMAI, EXEC. OFFICER: AND I WILL READ THE SHORT TITLE IN FOR THE RECORD. SO ALL THOSE WHO PLAN TO TESTIFY BEFORE THE BOARD, PLEASE STAND AND RAISE YOUR RIGHT HAND TO BE SWORN IN. I BELIEVE THAT THERE'S TWO INDIVIDUALS WHO ARE GOING TO SPEAK ON IT. 

SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. THEY ARE BRUCE HECKER AND ARNOLD SACHS. 

SACHI HAMAI, EXEC. OFFICER: IN THE TESTIMONY YOU MAY GIVE BEFORE THIS BOARD, DO YOU SOLEMNLY AFFIRM TO TELL THE TRUTH, THE WHOLE TRUTH AND NOTHING BUT THE TRUTH SO HELP YOU GOD? THANK YOU. ON THIS ITEM, THIS IS THE HEARING ON THE AMENDMENTS TO THE LOS ANGELES COUNTY CODE TITLE 8, CONSUMER PROTECTION AND BUSINESS REGULATIONS TO REFLECT TECHNICAL NON-SUBSTANTIVE MODIFICATIONS TO THE PUBLIC HEALTH FEES ESTABLISHED IN FISCAL YEAR 2011/'12 AND CREATE NEW AND AMENDED EXISTING CATEGORIES OF PUBLIC HEALTH PERMIT AND SERVICE FEES. AGAIN ON THIS ITEM, THE SECTION THAT RELATES TO THE ANIMAL KEEPER PORTION WILL BE CONTINUED -- NOT TWO WEEKS -- IT WILL BE CONTINUED TO JULY 30. 

SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. THANK YOU. MR. HECKER AND MR. SACHS, IF YOU WOULD COME FORWARD? SIR, PLEASE PROCEED. 

BRUCE HECKER: THE C.E.O. OF THE MOTION PICTURE AND TELEVISION MOBILE CATERERS ASSOCIATION. I'D LIKE TO RECOGNIZE AND THANK THE DEPARTMENT OF PUBLIC HEALTH VIA MENTAL HEALTH DIVISION FOR THEIR TRUE COLLABORATION WITH OUR ORGANIZATION TO ACHIEVE THE NEW MOTION PICTURE AND CATERING OPERATIONS PERMIT. SPECIFICALLY I'D LIKE TO THANK ANGELO BULEMO, TERRY WILLIAMS, PATRICA JOCUS AND THEIR MANY COLLEAGUES THAT WORKED WITH US FOR TWO YEARS TO DEVELOP THIS PERMIT. THE NEW PERMIT WILL BE FIRST OF ITS KIND IN THE NATION AND WILL BE LOOKED UPON AS THE MODEL FOR OTHER HEALTH DEPARTMENTS TO COPY AND IMPLEMENT ACROSS THE COUNTRY. OUR WORK IS NOT OVER. WE LOOK FORWARD TO CONTINUING OUR COLLABORATION WITH THE DEPARTMENT AND IMPLEMENTATION OF THE PERMIT AND EDUCATING OUR MEMBERS AND CUSTOMERS. WE SENT LETTERS TO YOUR OFFICE AND I'LL SUBMIT THEM HERE FOR YOUR RECORD. THANK YOU AGAIN. 

SUP. RIDLEY-THOMAS, CHAIRMAN: WE THANK YOU FOR YOUR TESTIMONY, SIR. NEXT SPEAKER, PLEASE? 

ARNOLD SACHS: YES, THANK YOU. GOOD MORNING AGAIN. ARNOLD SACHS. MY CONCERNS, ACTUALLY, GO MUCH DEEPER THAN YOU HAVE IN THE A.M.V., THE ABILITY -- YOU HAVE THE AUTHORITY BECAUSE YOU'RE THE ELECTED SUPERVISORS. BUT THE ABILITY AND THE WHEREWITHAL TO CREATE THIS KIND OF ORDINANCE BASED ON PAST HISTORIES WITH OTHER DEALINGS THAT YOU'VE DABBLED IN. AND I SPEAK SPECIFICALLY OF METRO, THAT YOU CAN DO CERTAIN THINGS THERE THAT ARE SO BEYOND THE REALM OF REALITY THAT IT MAKES PEOPLE'S HEADS SPIN. BUT THEN YOU'LL COME BACK HERE AND USE THE SAME, I DON'T KNOW, TECHNIQUE? THE SAME, WHATEVER, TO CREATE ORDINANCES THAT WILL AFFECT 10 MILLION PEOPLE. BECAUSE THAT'S THE POPULATION OF THE COUNTY. I SPECIFICALLY SAY HERE YOU HERE ON JUNE 27, YOU ARE MAKING AN AMENDMENT TO THE MEASURE R TRAFFIC RELIEF PROGRAM. BUT IN APRIL 28 OF 2004 YOU ARE MODIFYING STATE LAW. HOW COULD THAT POSSIBLY BE? WHOEVER HEARD OF SUCH STUPIDITY? YET THERE'S NO RHYME OR REASON HERE. THERE'S NO QUESTIONING. THERE'S NO LEGAL AUTHORITY. DO WE HAVE A COUNTY COUNSEL WHO COULD CLARIFY WHAT IT MEANS TO MODIFY STATE LAW? HAS HE EVER HEARD OF ANY? WE HAVE SOMEBODY WHO IS IN THE STATE LEGISLATION. HAVE YOU EVER HEARD OF ANYBODY MODIFYING STATE LAW? THIS IS AMENDMENTS TO PUBLIC UTILITIES CODES RELATING TO THE PASADENA METRO BLUE LINE CONSTRUCTION AUTHORITY. AND THIS IS AN AMENDMENT TO THE AMENDMENT AND YET THE PROPERTY IS OWNED BY A PARTY THAT DOESN'T EVEN EXIST BY STATE LAW. AND NOW YOU'RE GOING TO TURN AROUND AND USE THE SAME AUTHORITY THAT CREATED THIS ILLEGAL PROPERTY, AND IF YOU WANT THE NUMBER IT'S 20071251559, IT'S REGISTERED AT THE COUNTY REGISTRAR AND RECORDER'S OFFICE. 

SUP. KNABE: MR. CHAIRMAN, WHAT DOES THIS HAVE TO DO WITH THE PUBLIC HEARING? 

ARNOLD SACHS: IT HAS TO DO WITH THE AUTHORITY THAT'S VESTED IN YOU TO CREATE STUFF LIKE THIS FOR METRO AND THEN TURN AROUND AND USE THE SAME AUTHORITY TO CREATE STUFF LIKE THIS FOR THE REST OF THE COUNTY. AND METRO'S IN THE SAME COUNTY. HOW CAN THAT POSSIBLY BE? 

SUP. KNABE: MR. CHAIRMAN, THIS HAS NOTHING TO DO WITH THE PUBLIC HEALTH CODE. PLEASE. 

ARNOLD SACHS: IT HAS EVERYTHING TO DO WITH YOUR AUTHORITY TO MAKE CHANGES TO THE PUBLIC HEALTH CODE. AND IF YOU CAN QUALIFY CHANGES LIKE THIS, THEN I'M REALLY SCARED ABOUT YOU QUALIFYING CHANGES IN THE PUBLIC HEALTH CODE. 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU VERY MUCH FOR YOUR TESTIMONY. YOUR TIME HAS EXPIRED. 

SUP. KNABE: YOUR FEAR IS NOTED. 

SUP. RIDLEY-THOMAS, CHAIRMAN: MADAM EXECUTIVE OFFICER, I THINK THE ITEM IS BEFORE US, IS IT NOT? 

SACHI HAMAI, EXEC. OFFICER: IT IS. AND IF YOU'D LIKE TO CLOSE THE PUBLIC HEARING ON THIS ITEM? 

SUP. RIDLEY-THOMAS, CHAIRMAN: SO ORDERED. SUPERVISOR KNABE MOVES. SUPERVISOR YAROSLAVSKY SECONDS. ITEM NO. 59 IS BEFORE US. AND I SEE NO -- 

SACHI HAMAI, EXEC. OFFICER: AS AMENDED. 

SUP. RIDLEY-THOMAS, CHAIRMAN: -- OBJECTIONS. AND IT IS BEFORE US AS AMENDED. PLEASE RECORD A UNANIMOUS VOTE ON THE MATTER. NEXT ITEM, PLEASE. 

SACHI HAMAI, EXEC. OFFICER: THANK YOU. I BELIEVE WE ARE READY FOR ADJOURNMENTS. 

SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. ALL THOSE WHO WISH TO BE HEARD BY WAY OF PUBLIC COMMENT ON ANY REMAINING ITEMS? 

SACHI HAMAI, EXEC. OFFICER: NO. WE'RE DONE WITH ALL OF THE ITEMS. WE JUST HAVE THE ADJOURNMENTS AT THIS POINT IN TIME AND THEN WE'LL HAVE THE PUBLIC COMMENT SESSION. 

SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. WE'LL MOVE WITH THE FIRST ORDER OF BUSINESS, WHICH IS TO ACKNOWLEDGE SUPERVISOR MOLINA IF SHE HAS ANY ADJOURNING MOTIONS. SUPERVISOR? 

SUP. MOLINA: I HAVE NONE, THANK YOU. 

SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. THANK YOU VERY MUCH. WE'LL MOVE, THEN, TO SUPERVISOR ANTONOVICH. ANY ADJOURNING MOTIONS, SUPERVISOR? 

SUP. ANTONOVICH: CHAIRMAN, MEMBERS, IF WE COULD MOVE IN MEMORY OF THE 19 FIREFIGHTERS OF THE PRESCOTT FIRE DEPARTMENT'S GRANITE MOUNTAIN HOT SHOTS. ALL OF THEM WERE IN THEIR EARLY 20S. THEY WERE MEMBERS OF AN ELITE CREW WHO WERE TRAGICALLY KILLED ON SUNDAY FIGHTING THE YARNELL HILL FIRE IN ARIZONA. THE TRAGEDY ALL BUT WIPED OUT THE 20-MEMBER CREW. THE TEAM WAS KNOWN FOR WORKING ON THE FRONTLINES OF THE REGION'S WORST FIRES. AMONG THOSE WERE SOUTHERN CALIFORNIA NATIVES KEVIN WOYJECK, CHRIS MACKENZIE AND BILLY WARNEKE. KEVIN OF SEAL BEACH PASSED AWAY AT THE AGE OF 21. HIS FATHER, JOE, IS A LOS ANGELES COUNTY FIRE CAPTAIN. KEVIN BEGAN AS A FIRE EXPLORER, DID TRAINING AT CAMP 9 IN THE SANTA CLARITA VALLEY. HE WAS ALSO A PARAMEDIC. CHRIS OF HEMET PASSED AWAY AT THE AGE OF 30. HE JOINED THE UNITED STATES FOREST SERVICE IN 2004, MOVING TO THE PRESCOTT FIRE DEPARTMENT. HIS FATHER, MIKE, WAS A FORMER MORENO VALLEY CAL FIRE CAPTAIN. BILLY OF HEMET PASSED AWAY AT THE AGE OF 25. A FOUR-YEAR VETERAN OF THE UNITED STATES MARINE CORPS WHO JOINED THE WILD LAND FIRE FIGHTING UNIT IN APRIL. ALSO GORDON BRICKEN, AN ACOUSTICAL ENGINEER AND FORMER SANTA ANA MAYOR PASSED AWAY AT THE AGE OF 76. HE WAS ALSO, PRIOR TO BEING A MAYOR AND COUNCILMEMBER, SERVING ON THEIR CITY'S PLANNING COMMISSION. HE HAD HELPED ESTABLISH THE SOUTHERN CALIFORNIA-BASED CIVIL WAR RESEARCH AND AUTHORED TWO BOOKS ON THE CIVIL WAR. GEORGE CAREY, DR. GEORGE CAREY, LONGTIME PROFESSOR OF GOVERNMENT AT GEORGETOWN UNIVERSITY, EXPERT IN U.S. POLITICAL THEORY, PASSED AWAY AT AGE 79. HE'D BEEN A MEMBER OF THE PHILADELPHIA SOCIETY BOARD OF TRUSTEES AND THE INTERCOLLEGIATE STUDIES INSTITUTE BOARD OF TRUSTEES. HE WAS ALSO INVOLVED WITH THE LATE DR. WILMORE KINDLE. HE SERVED ON THE COUNCIL OF THE NATIONAL ENDOWMENT FOR THE HUMANITIES AND WAS EDITOR OF THE POLITICAL SCIENCE REVIEWER. ERNESTO LUCERO, SR. PASSED AWAY AT THE AGE OF 80. HE WORKED AS A SOCIAL WORKER FOR THE DEPARTMENT OF SOCIAL SERVICES AS WELL AS WORKING AT MCCLAREN HALL. HE BECAME A TEEN ACTIVIST AND STARTED THE LA PUENTE TEEN POST, A YOUTH CLUB CALLED THE "LITTLE MINNOWS." HE ORGANIZED THE FOOD AND TOY DONATIONS AND IS SURVIVED BY HIS WIFE, MARY; AND HIS SON, ERNESTO, JR. AND HE ALWAYS LOOKED FORWARD TO PARTICIPATING IN THE MEMORIAL DAY VETERANS AFFAIRS PROGRAM THAT WE DO AT ARCADIA PARK. AND A GOOD FRIEND, FREDERIC STEINBERG PASSED AWAY THIS PAST WEEK. HE WAS A GRADUATE OF THE UNIVERSITY OF SOUTHERN CALIFORNIA LAW SCHOOL. FRED WORKED AS A LITIGATOR. AND HE IS SURVIVED BY HIS SONS, OLIVER AND GILES; AND HIS TWO BROTHERS, HERBERT, WHO WAS A CLASSMATE OF MINE, AND ARNOLD, WHO IS ONE OF MY POLITICAL CONSULTANTS, ARNOLD STEINBERG. SO THOSE ARE MY ADJOURNMENT MOTIONS, MR. CHAIRMAN. 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU VERY MUCH, SUPERVISOR. 

SUP. ANTONOVICH: LET ME JUST SAY THERE'S A LOT OF TALK ABOUT DIVERSITY IN IN THE MOTION PICTURE INDUSTRY AND THE NEED FOR DIVERSITY. AND I FIND IT QUITE IRONIC THAT DISNEY HAS JUST MADE A QUARTER OF A BILLION DOLLAR FILM IN WHICH THE LATE GREAT JAY SILVERHEELS IS BEING PORTRAYED IN TONTO AS A NON-INDIAN. HAVING A NON-INDIAN PLAY THAT NATIVE-AMERICAN, PLAY THAT PART IS QUITE INSENSITIVE TO THE NATIVE AMERICANS AND TO THE GREAT NATIVE AMERICAN ACTORS IN THIS NATION. SO I THINK THAT'S A VERY SLAP IN THE FACE. 

SUP. RIDLEY-THOMAS, CHAIRMAN: NOTED. SUPERVISOR YAROSLAVSKY FOLLOWED BY SUPERVISOR KNABE. 

SUP. YAROSLAVSKY: ADJOURN IN THE MEMORY OF RICHARD MATHESON, RESIDENT OF OUR DISTRICT AND A PROLIFIC AUTHOR AND SCREEN WRITER. RECENTLY PASSED AWAY AT THE AGE OF 87 IN HIS HIDDEN HILLS HOME. HE BEGAN HIS CAREER IN 1950 WITH HIS FIRST PUBLISHED SCIENCE FICTION SHORT STORY AND SOON BECAME ONE OF THE HORROR/FANTASY/SCIENCE FICTION GENRE'S TOP WRITERS PRODUCING MANY SHORT STORIES, NOVELS, MOVIE ADAPTATIONS AND ORIGINAL T.V. SCRIPTS. HIS BEST KNOWN WORK INCLUDES THE NOVELS AND SCREEN PLAYS FOR "THE INCREDIBLE SHRINKING MAN," "I AM LEGEND," "THE LEGEND OF HELL HOUSE" AND MANY CLASSIC "TWILIGHT ZONE" SCRIPTS. HE IS SURVIVED BY HIS WIFE, RUTH ANN; TWO SONS, R.C. AND CHRISTIAN; TWO DAUGHTERS, BETTINA MATHESON MAYBERRY, AND ALI MARIE MATHESON; 7 GRANDCHILDREN AND TWO GREAT GRANDCHILDREN. LINDA PALMER, RESIDENT OF OUR DISTRICT FROM CALABASAS, PASSED AWAY AT THE AGE OF 80 AFTER A LONG ILLNESS. SHE HAD BEEN A LONG-SERVING PRESIDENT OF THE SANTA MONICA MOUNTAINS TRAILS COUNCIL AND AN ORIGINAL MEMBER OF THE SANTA MONICA MOUNTAINS CONSERVANCY'S ADVISORY BOARD. A DEDICATED EQUESTRIAN AND MOVED TO CALABASAS IN THE 1970S WITH HER HUSBAND, CHILDREN AND A PAIR OF HORSES. SHE WAS A STAUNCH ADVOCATE FOR TRAILS AND OPEN SPACE PRESERVATION. SHE HELPED DESIGN AND PROMOTE L.A. COUNTY'S TRAIL PLAN FOR THE SANTA MONICA MOUNTAINS, DESIGNED THE UPPER STUNT HIGH TRAIL AND WITH OTHER VOLUNTEERS BUILT IT, HELPED DEVELOP THE JUAN BAUTISTA DE ANZA NATIONAL HISTORICAL TRAIL AND SERVED AS AN ADVISER TO BOTH LOS ANGELES AND VENTURA COUNTIES AND THEIR CITIES INVOLVING THE SANTA MONICA MOUNTAINS AS WELL AS TO THE CALIFORNIA COASTAL COMMISSION REGARDING TRAIL ISSUES. SHE IS SURVIVED BY HER HUSBAND, ROBERT, AN ACTOR WHO PERFORMED UNDER THE NAME BOYD HOLISTER; AND FIVE CHILDREN, MICHAEL HUTCHINGS AND JOHN HUTCHINGS, ROBERT PALMER, JR., ADAM PALMER, AND BELINDA PALMER; AND SIX GRANDCHILDREN. THAT'S ALL I HAVE. 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU VERY MUCH, SUPERVISOR YAROSLAVSKY. SUPERVISOR KNABE, PLEASE. 

SUP. KNABE: THANK YOU. MR. CHAIRMAN, I KNOW THAT MIKE MENTIONED THE 19 FIREFIGHTERS THAT SO BRAVELY GAVE UP THEIR LIVES. ONE IN PARTICULAR, KEVIN WOYJECK, I'VE KNOWN HIM SINCE HE'S BEEN A VERY YOUNG BOY. HIS FATHER, JOE, IS A GOOD FRIEND OF OUR FAMILY'S, WAS OVER THERE SUNDAY NIGHT WITH THE FAMILY. IT'S JUST SO TRAGIC. AS A TEENAGER, HE WAS ONE OF OUR FIRE EXPLORERS. HE WAS PART OF, AS YOU KNOW, THE BRUSH TEAM IN PRESCOTT. HE WANTED TO BE A FIREFIGHTER JUST LIKE HIS DAD, CAPTAIN JOE. A REMARKABLE YOUNG MAN. AND WAS ALWAYS WILLING TO LEND A HAND VOLUNTEERING AS A LIFEGUARD, TEACHING KIDS TO FISH, TO HELPING OUT AT OUR L.A. COUNTY FIRE MUSEUM. HE TRULY WAS A HERO. HE'S SURVIVED BY HIS PARENTS, JOE AND ANNA, BROTHER BOBBY, SISTER MADDIE, HIS GRANDPARENTS AND MANY FAMILY AND FRIENDS. HE WILL BE GREATLY MISSED. JUST AN INCREDIBLE, INCREDIBLE YOUNG MAN. HIS VISION TO DO WHAT HE DID TO BECOME ONE OF THOSE HOT SPOT FIREFIGHTERS WAS NOT TO LIVE OFF HIS DAD'S NAME AND IMMEDIATELY BECOME AN L.A. COUNTY FIREFIGHTER BUT TO CREATE HIS OWN RECORD. AND THAT'S WHY HE WAS WHERE HE WAS AND IS WHAT HE WAS. HE IS A TRUE HERO TO ALL OF US. OUR THOUGHTS AND PRAYERS ARE WITH THE FAMILY, NOT ONLY WITH KEVIN'S FAMILY BUT THE MANY OTHERS THAT GAVE UP THEIR LIVES. ALSO THAT WE ADJOURN IN MEMORY OF CLAUDE TRUJILLO, BELOVED UNCLE OF MY CHIEF OF STAFF, RICK VELASQUEZ AND LONGTIME RESIDENT OF WHITTIER PASSED AWAY LAST WEEK. SURVIVED BY SISTER, ELOISA, DEARLY MISSED BY HIS FAMILY AND FRIENDS AND WE'D LIKE TO EXTEND OUR CONDOLENCES TO RICK AND HIS FAMILY. ALSO ADJOURN IN MEMORY OF PAUL TEIXEIRA, SUPERVISOR FROM THE SAN LUIS OBISPO COUNTY, WHO PASSED AWAY UNEXPECTEDLY AT THE AGE OF 57 LAST WEEK. HE WAS ELECTED IN 2010, WAS BOARD CHAIR THIS YEAR. VERY INVOLVED, OBVIOUSLY, IN THE NUMEROUS ASPECTS OF SAN LUIS OBISPO COUNTY LIFE. HE ALSO PARTICIPATED IN THE 2010-11 C.S.A.C. INSTITUTE. LEAVES A LEGACY OF PROVIDING FAIR, HONEST AND COMMITTED REPRESENTATION AND LEADERSHIP. HE IS SURVIVED BY HIS WIFE, DEANNA; FIVE CHILDREN. WE WANT TO EXTEND OUR DEEPEST CONDOLENCES TO HIS FAMILY AND FRIENDS. ALSO THAT WE ADJOURN IN MEMORY OF ANOTHER LONGTIME FRIEND OF OUR FAMILY, RUFINA CHAVEZ, FORMER PRESIDENT OF THE WOMEN'S CLUB OF ARTESIA-CERRITOS. SURVIVED BY HER DAUGHTER, TERRI, SHE WILL BE GREATLY MISSED. A GREAT LADY. ALSO THAT WE ADJOURN IN MEMORY OF MR. AL STONE, LONG BEACH NATIVE AND U.S.C. CHARGER FAN, WHO PASSED AWAY AT THE AGE OF 86. GRADUATED FROM WILSON HIGH SCHOOL IN LONG BEACH. COAST GUARD DURING WORLD WAR II. RETURNED TO LONG BEACH. HE WAS A MEMBER OF THE CENTURY CLUB, WHICH HELPS YOUNG ATHLETES IN LONG BEACH FOR OVER 35 YEARS, PETROLEUM CLUB AND MANY OTHER LOCAL GROUPS. HE WAS AN AVID TROJAN FAN MORE THAN 60 YEARS AS HIS UNCLE JESS HILL WAS A LEGENDARY PLAYER, COACH AND ATHLETIC DIRECTOR. HE WILL BE MISSED BY ALL. SURVIVED BY HIS WIFE, DIANE; AND DAUGHTER, SHELLI. ALSO WE ADJOURN IN MEMORY OF SERVANDO YZAGUIRRE, BELOVED FATHER BEFORE ONE OF OUR CITY'S LONGTIME STAFF MEMBERS VIRGINIA BONITO, WHO PASSED AWAY RECENTLY WITH HIS FAMILY BY HIS SIDE AT THE AGE OF 80. SURVIVED BY HIS WIFE OF 54 YEARS, MARIA; FOUR SONS AND TWO DAUGHTERS; 16 GRANDCHILDREN AND TWO GREAT GRANDCHILDREN. HE WILL BE MISSED BY ALL WHO KNEW HIM. ALSO ANOTHER LONGTIME RESIDENT OF OUR DISTRICT PASSED AWAY AT THE AGE OF 87, MANUAL BAYENAS, WAS A MARINE AND ARMY VETERAN. HE HAD A 40-YEAR CAREER WITH LANGENDORF BAKERY IN THE CITY OF COMMERCE. SURVIVED BY HIS WIFE, IRIS; A SON, THREE DAUGHTERS AND 10 GRANDCHILDREN. THOSE ARE MY ADJOURNMENTS, MR. CHAIRMAN. 

SUP. RIDLEY-THOMAS, CHAIRMAN: I THANK YOU, SUPERVISOR KNABE. IT'S AN APPROPRIATE THAT ALL MEMBERS ADJOURN IN MEMORY OF KEVIN. 

SUP. KNABE: I APOLOGIZE. ALL MEMBERS. 

SUP. RIDLEY-THOMAS, CHAIRMAN: ALL MEMBERS FOR THAT TRAGIC YOU INCIDENT. AND OUR CONDOLENCES ARE INDEED EXTENDED TO HIS ENTIRE FAMILY. YOU MAY I ASK THAT WE TAKE NOTE OF THE PASSING OF ETTA ROSA OLA BETZ, THE MOTHER OF ROWLAND BETZ. HER SERVICES WILL BE NEXT TUESDAY AT THE SPAULDING MORTUARY AT 11 A.M. IN LOS ANGELES. A MATRIARCH OF THE FAMILY, AND WE ACKNOWLEDGE HER PASSING WITH GREAT SYMPATHY FOR THE BETZ FAMILY. ADDITIONALLY, WE WISH TO ACKNOWLEDGE THE PASSING OF RAYMOND D. WILDER, BORN MARCH 1, 1941 AND PASSED ON JUNE 23. ATTENDED THE UNIVERSITY OF ARKANSAS AT PINE BLUFF AND LATER MOVED TO LOS ANGELES, WHERE HE CONTINUED HIS EDUCATION AT THE UNIVERSITY OF SOUTHERN CALIFORNIA. HE BEGAN HIS PROFESSIONAL CAREER AS A MANAGER AT TELEDYNE WESTERN AND CABLE. HE DESIRED TO DO MORE FOR HIS COMMUNITY, MR. WILDER STARTED HIS OWN BUSINESS, THE WILDER SEA FOOD CENTER. HE ALSO FORMED THE ROCKHAM DEVELOPMENT COMPANY, WHICH ASSISTED PROVIDING AFFORDABLE HOUSING TO THE COMMUNITY. 1983, HE AND HIS WIFE FOUNDED THE TENDER CARE CHILD DEVELOPMENT CENTER IN LOS ANGELES, A PRIVATE PRESCHOOL SERVING SOME 180 CHILDREN, AGES 2 THROUGH 5. TENDER CARE WAS ESTABLISHED IN 1988 AND AN ELEMENTARY SCHOOL WAS ESTABLISHED IN 1994 WHICH WAS NAMED WILDER'S PREPARATORY ACADEMY AT THAT TIME. IT WAS THE FIRST CHARTER SCHOOL TO BE APPROVED IN THE CITY OF INGLEWOOD. AFTER 30 YEARS, MR. WILDER AND HIS WIFE WERE KNOWN TO BE INDUSTRY LEADERS IN THE FIELD OF EDUCATION THROUGHOUT THEIR COMMUNITY AND VARIOUS PARTS OF THE NATION. MORE THAN 14,000 STUDENTS HAVE MATRICULATED THROUGH THEIR CHILD DEVELOPMENT AND CHARTER SCHOOL ALONG WITH SOME 400 JOBS PROVIDED TO THE COMMUNITY. HE WAS HONORED IN LOCAL PUBLICATIONS IN CONJUNCTION WITH HIS ANNUAL M.L.K. DRUM MAJOR AWARD FOR JUSTICE. HE WILL BE REMEMBERED FOR HIS LOVING AND KIND HEART AND HIS DEVOTION TO THE WELL-BEING OF CHILDREN AND THEIR EDUCATION. HE HAS BEEN RECOGNIZED BY DOZENS OF ORGANIZATIONS AND GOVERNMENT, GOVERNMENT OFFICIALS LOCALLY AND NATIONALLY. HE IS SURVIVED BY MANY FAMILY FRIENDS WHO WILL MISS HIM DEARLY. RAYMOND D. WILDER. AND, FINALLY, MEMBERS OF THE BOARD, CONGRESSMAN WILLIAM GRAY, III PASSED YESTERDAY AT THE AGE OF 71. BORN IN BATON ROUGE, LOUISIANA. HE MOVED WITH HIS FAMILY AT AN EARLY AGE TO PHILADELPHIA, PENNSYLVANIA. AFTER RECEIVING DEGREES FROM FRANKLIN MARSHAL COLLEGE, A DEGREE FROM DREW THEOLOGICAL SEMINARY AND A DEGREE FROM PRINCETON THEOLOGICAL SEMINARY, HE SUCCEEDED HIS FATHER AS THE PASTOR OF BRIGHT HOPE BAPTIST CHURCH, A POSITION HE HELD UNTIL 2007. HE WAS ELECTED IN 1978 TO REPRESENT PENNSYLVANIA'S SECOND CONGRESSIONAL DISTRICT, WHICH ENCOMPASSED MUCH OF THE CITY OF PHILADELPHIA AND ITS SURROUNDING AREAS. DURING HIS SIX TERMS, HE ROSE THROUGH THE RANKS TO BECOME THE FIRST AFRICAN-AMERICAN MAJORITY WHIP AND THE FIRST AFRICAN-AMERICAN CHAIRMAN OF THE HOUSE BUDGET COMMITTEE. FOLLOWING HIS CAREER IN CONGRESS, HE ASSUMED THE PRESIDENCY OF THE UNITED NEGRO COLLEGE FUND, WHERE HE RAISED MORE THAN $2.3 BILLION FOR MINORITY INSTITUTIONS OF HIGHER LEARNING. HE SERVED AS A SPECIAL ADVISER TO PRESIDENT WILLIAM JEFFERSON CLINTON FOR THE PEOPLE OF HAITI. HE AND HIS WIFE, ANDREA, HAD THREE SONS. CONGRESSMAN BILL GRAY WAS, IN FACT, A TRUE PUBLIC SERVANT, A MAN OF GOD, AND HIS LEGACY WILL LIVE ON. INDEED HE WILL BE MISSED DEARLY. WILLIAM H. GRAY, III. THAT CONCLUDES MY ADJOURNING MOTIONS. AND THAT WILL BE THE ORDER ON ALL THOSE THAT HAVE BEEN READ AT THIS POINT. MADAM EXECUTIVE OFFICER? MR. CHAIRMAN AND MEMBERS OF THE BOARD, THE LAST PORTION OF THE AGENDA WOULD BE PUBLIC COMMENT. 

SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. LADIES AND GENTLEMEN, WE WILL NOW ACKNOWLEDGE YOUR OPPORTUNITY TO BE HEARD BEFORE THE BOARD. WE HAVE THE FOLLOWING PERSONS LISTED: ARNOLD SACHS, ERIC PREVEN, CHRISTOPHER MARTIN, LORI MARTIN, JOCELYN JOHNSON, PATRICIA MULCAHEY, OSCAR JOHNSON, DAVID SERRANO, ROSIE BALDERES, MELLO DESIRE, IN THAT ORDER IF YOU WOULD COME. 

ERIC PREVEN: YES, IT'S ERIC PREVEN, THE COUNTY RESIDENT FROM 3. I NOTE THE TWO MINUTES, BUT I THOUGHT YOU WERE A THREE-MINUTE MAN. EVIDENTLY NOT. THAT'S VERY UPSETTING BECAUSE I HAVE A LOT TO SAY. IN PARTICULAR THE ITEM 1-D, WHICH IS ON THE AGENDA TODAY, SCHEDULED FOR 9:30 AM, COMMUNITY DEVELOPMENT COMMISSION, WE'VE TALKED ABOUT IT BEFORE. IT'S A GROUP THAT PROVIDES ALMOST HALF A BILLION DOLLARS IN SERVICES TO PEOPLE WHO NEED IT IN GENERAL. THEY ALSO HAVE SOME PROBLEMS WITH OVERSIGHT. LAST WEEK THERE WAS A PUBLICATION BY THE AUDITOR-CONTROLLER THAT LOOKED AT THEIR WORK AND THE WAY THEY PROCURE CONTRACTS AND THE WAY THAT THEY DO BUSINESS AND FOUND A FAIR AMOUNT OF UNSATISFACTORY WORK. THE ONE THAT CAUGHT MY ATTENTION MOST WAS THE LAST COUPLE YEARS THEY RAN A $100 MILLION SHORTFALL. IN OTHER WORDS, THEY HAD HALF A BILLION TO SPEND. THEY ONLY SPEND 400 MILLION FOR A VARIETY OF REASONS. THEY'RE UNDER SPENDING IN A CATEGORY DURING ONE OF THE WORST ECONOMIC TIMES IN THE LAST SEVERAL YEARS. SO IT'S VERY UPSETTING. AND THIS IS A GROUP THAT I'VE SAID BEFORE TAKES A GOOD PIECE OF BUSINESS THAT THEY GET FROM THE FEDERAL GOVERNMENT AND THE STATE FOR ADMINISTERING IT. AND IT'S VERY, VERY UPSETTING. AND I REALLY WISH -- THAT THIS IS THE SAME GROUP THAT HAD THE ENTERPRISE RENT-A-CAR PROCUREMENT THAT WAS SO FISHY CONNECTED TO THE LOBBYING FIRM THAT YOU HEARD ME TALK ABOUT, ENGLANDER, KNABE AND ALLEN. AND YOU KNOW, IN THE NEWSPAPER TODAY, THERE'S AN $11 MILLION, $12 MILLION CHARGE THAT WERE BEING FOR THOSE SECTION 8, YOU KNOW, INCONVENIENCES OR CIVIL RIGHTS VIOLATIONS OUT IN THE VALLEY. AND REX PARIS IS IN THE NEWSPAPER SAYING LET THE COUNTY PAY FOR IT. I'M NOT PAYING ONE NICKEL. VERY UPSETTING STUFF, GUYS. VERY UPSETTING. AND THIS IS ALL THAT SAME GROUP. THE GRAND JURY IS OUT AND THEY'VE GOT THE CIVIL GRAND JURY HAS POSTED THEIR REPORTS. AND THE REPORTS ARE LATE. THEY'RE SIX MONTHS AGO. SO IT'S KIND OF WEIRD. THEY MAY BE ON TIME BUT THEY DON'T DO US MUCH GOOD NOW. NO REFERENCE TO THE CITIZENS COMMISSION ON JAIL VIOLENCE IN THEIR DETENTION REPORTS, WHICH I FIND TRULY AN OUTSTANDING PIECE OF WHITE WASHING. HOW THAT COULD THAT NOT COME UP IS JUST A SHOCKER. I DID LOOK AT THE HOTLINE FOR THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES. 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU. 

ERIC PREVEN: I KNOW YOU'RE INTERESTED. 

SUP. RIDLEY-THOMAS, CHAIRMAN: WE'LL THANK YOU FOR YOUR TESTIMONY. 

ERIC PREVEN: TWO MINUTES. THANK YOU, SIR, HAVE A NICE FOURTH OF JULY. 

SUP. RIDLEY-THOMAS, CHAIRMAN: LIKEWISE, THANK YOU. 

CHRISTOPHER MARTIN: GOOD MORNING. MY NAME IS CHRISTOPHER MARTIN. I'M ACTUALLY A RESIDENT OF RIVERSIDE COUNTY. I'VE RESIDED HERE LEGALLY AS A LEGAL RESIDENT ALIEN SINCE 1983 HERE IN SOUTHERN CALIFORNIA AND I ALSO WORK ALL AROUND SOUTHERN CALIFORNIA, INCLUDING LOS ANGELES COUNTY. I'M A MOTORCYCLE MESSENGER. AND I'D LIKE TO RECOMMEND THAT YOU PUT INTO EFFECT AN ORDINANCE THAT ALLOWS MOTORCYCLES TO PARK ON THE SIDEWALK INSTEAD OF INTO THE STREET PROVIDE THAT HAD THE MOTORCYCLE IS PARKED IN A SAFE MANNER THAT DOES NOT OBSTRUCT THE PEDESTRIAN FLOW OF TRAFFIC. THERE ARE MANY TIMES WHEN I'VE SEEN CAR DRIVERS FRUSTRATED TRYING TO PARK IN A METERED PARKING SPOT THAT'S COMPLETELY OCCUPIED BY ONE MOTORCYCLE. MANY DRIVERS DON'T THINK THAT THIS IS FAIR. BUT THAT'S THE LAW. A MOTORCYCLE HAS TO PARK IN A LEGAL PARKING SPOT. ANOTHER RECOMMENDATION THAT I HAVE FOR THE BOARD IS THAT YOU INSTITUTE A TIERED MOTORCYCLING PROGRAM THAT ALLOWS -- THAT RESTRICTS NEW MOTORCYCLE RIDERS TO A -- (FEEDBACK). 

SUP. RIDLEY-THOMAS, CHAIRMAN: YOU MAY PROCEED. 

CHRISTOPHER MARTIN: YEAH, THAT WOULD RESTRICT NEW MOTORCYCLE DRIVERS TO A LOWER OUTPUT MOTORCYCLE FOR THE FIRST YEAR OF THEIR INTRODUCTION INTO RIDING MOTORCYCLES. THIS IS SOMETHING THAT I WOULD SUGGEST IN THE NAME OF SAFETY TO REDUCE THE NUMBER OF MOTORCYCLE ACCIDENTS IN LOS ANGELES COUNTY. AND THAT'S SOMETHING THAT I THINK THAT YOU SHOULD ALL TAKE INTO CONSIDERATION. AND I THANK YOU FOR YOUR TIME. 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU FOR YOUR TESTIMONY. WE WILL TAKE THE NEXT SPEAKER, PLEASE. MA'AM? 

LORI MARTIN: LORI MARTIN ONCE AGAIN. I LIVE IN RIVERSIDE. MR. ANTONOVICH, TO ADDRESS YOUR CONCERNS OF WHAT SECTION THIS IS FROM, THIS IS FROM THE GLENDORA REGIONAL OFFICE, WHICH I RECENTLY FOUND THAT THIS WORKER HAD ACTUALLY BEEN TRANSFERRED OVER TO POMONA'S REGIONAL OFFICE. SO AS FAR AS MY SITUATION AND WHAT S.P.A. AREA IT IS, IT'S UP IN THE AIR AT THIS POINT IN TIME. MY REQUEST IS THAT THIS WORKER BE IMMEDIATELY TERMINATED FOR SUCH ACTIONS THAT CAN COST THE COUNTY AND TAXPAYERS OF L.A. QUITE A BIT OF MONEY. THIS IS THE WHOLE PURPOSE OF THE BLUE RIBBON COMMISSION IS TO CREATE TRANSPARENCY, ACCOUNTABILITY. HERE I HOLD IN MY HAND PROOF OF FRAUD. ARE YOU GOING TO HOLD THIS WORKER ACCOUNTABLE AND CHARGE HER WITH A CRIMINAL CHARGE? IF I WERE TO DEFRAUD YOUR COUNTY, YOU WOULD PROBABLY CHARGE ME WITH A CRIMINAL CHARGE. NOT ONLY DID SHE DEFRAUD A CORPORATION, SHE ALSO DEFRAUDS THE NAME OF SOCIAL WORKER. THEY HAVE, BEFORE ENTERING INTO THEIR POSITION, TAKEN A VOW OF HONESTY. ANY TIME THEY SUBMIT REPORTS TO THE COURT, IT IS TAKEN AS FACT. HOW CAN IT BE WHEN I'M PROVING TO YOU, PROVING, WITH MINUTE ORDERS IN HAND, NO SUCH ORDERS EXIST. PLEASE MAINTAIN CONTROL OF MALICIOUS INDIVIDUALS. GET RID OF UNIONIZATION OF SOCIAL WORKERS. THAT WAY YOU CAN TERMINATE THEM WITHOUT INTERFERENCE OF A UNION REPRESENTATIVE. I AM AWARE THAT THAT'S SOMETHING THAT YOU GUYS HAVE TO DEAL WITH. BUT, PLEASE, CIRCULATE THESE UNIONIZED WORKERS OUT. THANK YOU. 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU FOR YOUR TESTIMONY. WE'LL TAKE THE NEXT SPEAKER, PLEASE. MA'AM? 

JOCELYN JOHNSON: YES. MY NAME IS JOCELYN JOHNSON. MARK RIDLEY-THOMAS AND BOARD MEMBERS, I'M HERE BECAUSE I'M HAVING A PROBLEM WITH MY APPLYING FOR CALFRESH BENEFITS. ON JUNE 11, I FILED A PETITION FOR WRIT OF MANDATE. I'M GOING TO LEAVE A COPY WITH YOU IF YOU WOULD LIKE IT. I HAVE TO AMEND IT BECAUSE I HAVE TO NAME THE DEPARTMENT OF PUBLIC SOCIAL SERVICE. I NAMED THE WRONG DEPARTMENT. AND I HAVE AN ALL-COUNTY LETTER THAT SPECIFIES THEY'RE DISCRIMINATING AGAINST ME I GUESS BECAUSE THEY DON'T SEE THAT I'M DISABLED, THEY CAN'T VISIBLY SEE MY DISABILITIES. AND THEY'RE NOT GIVING ME THE ALLOWANCES OR DEDUCTIONS THAT I'M ENTITLED TO BECAUSE OF THAT, THEREBY MAKING ME INELIGIBLE FOR THE BENEFIT. AND I WOULD REALLY LIKE SOMEONE ELSE TO INTERVENE AND LOOK INTO THIS FOR ME BECAUSE I'M GOING TO CONTINUE TO PROCEED WITH THE WRIT OF MANDATE. AND I DO HAVE ANOTHER STATE HEARING ON THE NINTH. THIS WILL BE THE FIFTH, FOURTH OR FIFTH HEARING. 

SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHTY. 

JOCELYN JOHNSON: I JUST THINK THERE'S SOMETHING GOING WRONG DOWN THERE IN THAT CUDAHY OFFICE THAT I THINK PEOPLE SHOULD LOOK INTO. WHEN I TALK ON THE PHONE, I'M TALKING TO ONE PERSON WITH A THICK LATIN ACCENT SAYING THAT SHE'S MY WORKER. WHEN I GET THERE, THERE'S SOMEBODY TOTALLY DIFFERENT. SO I NEVER KNOW WHO I'M TALKING TO OR SPEAKING WITH. AND THEY'RE SAYING THAT I WAS RECEIVING FOOD STAMPS FOR A PERIOD THAT I DID NOT RECEIVE ANYTHING. BUT THEY HAVE IT DOCUMENTED THAT I WAS RECEIVING IT AND I WAS NOT. 

SUP. RIDLEY-THOMAS, CHAIRMAN: AND WHERE DO YOU RESIDE, MA'AM? 

JOCELYN JOHNSON: I LIVE IN CITY OF LYNWOOD. AND CUDAHY IS MY DISTRICT, THAT'S WHERE I HAVE TO GO. 

SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. WE'LL HAVE SOMEONE HAVE A CONVERSATION WITH YOU IF YOU WOULD JUST TAKE A SEAT THERE. WE'LL ASSIGN A STAFF PERSON TO YOU RIGHT AWAY. 

JOCELYN JOHNSON: I WILL. THANK YOU SO MUCH. 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU FOR YOUR TESTIMONY. MA'AM? 

ROSIE BALDERAS: HI, MY NAME IS ROSIE BALDERES, I WAS HERE LAST WEEK AND I HAVE A COUPLE OF ISSUES THAT I BROUGHT UP LAST WEEK. I DO HAVE A PARTNER THAT HER NAME'S DAISY BRONX AND SHE'S PART OF GABRIEL'S JUSTICE WITH GABRIEL FERNANDEZ, THE CHILD ABUSE CASE. OKAY, I'M GOING TO START OFF BY SAYING I'M HERE TODAY TO ADVOCATE FOR THE INJUSTICE HAPPENING TO OUR CHILDREN, THE LACK OF EFFORT BY CHILD DEVELOPING SERVICE. WHETHER IT'S BECAUSE OF INSUFFICIENT RESOURCES, NOT ENOUGH STAFF OR LACK OF INTEREST, MORE NEEDS TO BE DONE. A CASE WAS ACTUALLY JUST BROUGHT TO OUR ATTENTION WHERE THERE IS A FIVE-YEAR-OLD BY THE NAME OF NICHOLAS THAT WE'RE TOLD IS BEING ABUSED BY HIS MOTHER. GRANDMOTHER HAD TO RETURN HIM ON SUNDAY WITH BRUISING ON HIS FACE. BASED ON THE INFORMATION WE HAVE, THE FATHER'S FAMILY WAS TOLD THAT THE CHILD WAS TRAINED OR GROOMED TO SAY THAT HE'S BEING ABUSED. WE ARE DEMANDING THAT THIS CASE BE RE-EVALUATED BY AN AGENCY WITH MORE AUTHORITY IN ORDER TO PREVENT ANOTHER TRAGEDY LIKE GABRIEL FERNANDEZ FROM BEING REPEATED. WE NEED TO ACT NOW IN ANSWER TO NICHOLAS'S CRY FOR HELP. IS THERE, I GUESS, BECAUSE I'M NEW TO ALL OF THIS, IN THIS CASE, LIKE GRANDMOTHER HAD TO RETURN HIM. IS THERE ANYTHING THAT SHE COULD HAVE DONE OR WE CAN DO NOW IF SHE RETURNS HIM TO THE -- TO WHO HAS COURT ORDER LIKE THE MOTHER AS FAR AS -- NO? -- AS FAR AS -- YEAH -- AS FAR AS LIKE, OKAY, THE COURT ORDER STATED ACCORDING TO THE GRANDMOTHER THAT -- 

SUP. RIDLEY-THOMAS, CHAIRMAN: MA'AM? YOUR TIME HAS EXPIRED. TELL ME WHERE YOU RESIDE. 

ROSIE BALDERAS: HUNTINGTON PARK. 

SUP. RIDLEY-THOMAS, CHAIRMAN: HUNTINGTON PARK? 

ROSIE BALDERAS: YEAH. 

SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. THEN THERE IS SOMEONE FROM THE DEPARTMENT WHO CAN TALK WITH YOU AND ANSWER SOME OF THOSE QUESTIONS. AND YOU CAN FOLLOW-UP WITH THE APPROPRIATE SUPERVISOR IN QUESTION. ALL RIGHT. WE THANK YOU VERY MUCH FOR YOUR TESTIMONY. WE'LL TAKE THE NEXT PERSON WHO WISHES TO BE HEARD. MA'AM? 

MELLO DESIRE: HI. MY NAME IS MELLO DESIRE. THERE ARE SEVERAL ISSUES. I MOVED TO LOS ANGELES A COUPLE YEARS AGO. WHAT'S MOST IMPORTANT, THE UNBALANCE IN LOS ANGELES WHERE YOU HAVE 100,000 HOMELESS KIDS EVERY NIGHT, AND KIDS ESPECIALLY IN COMPTON, WATTS, EAST L.A., BOYLE HEIGHTS, MACARTHUR PARK, INGLEWOOD AND SOUTH CENTRAL, WHEN YOU ASK A KID IN THESE AREAS WHAT DO YOU WANT TO BE WHEN YOU GROW UP? THEY STATE THEY WANT TO BE A FOOTBALL PLAYER, BASKETBALL PLAYER, RAPPER OR SOMETIMES EVEN GANGSTER. BUT IF YOU ASK A KID IN HOLLYWOOD, BEVERLY HILLS, WHAT WOULD YOU LIKE TO BE WHEN YOU GROW UP? THEY SAY I WANT TO BE AN AESTHETICIAN, CAN'T EVEN SPELL THAT, BUT DOCTOR, LAWYER OR FRENCH TEACHER, THEY GIVE SO MANY OPTIONS. BUT YET, HOLLYWOOD, THAT SPENDS MILLIONS OF DOLLARS ON WASTEFUL MOVIES DAILY AND A KID NEXT DOOR HASN'T EVEN EATEN, THAT IS AN UNBALANCE THAT WE'RE TRYING TO FIX. AND SO FOR THE LAST SIX MONTHS, WE HAVE CREATED A PERFORMING ARTS INITIATIVE FOR AT-RISK YOUTH AND HOMELESS KIDS THAT WE HAVE BEEN USING IN THE LAST SIX MONTHS. A LOT OF THEM DO THE SHOWS BUT THEY CAN'T STAY BECAUSE THEY HAVE NO STABILITY. WE WANTED TO HOUSE THESE KIDS. AND WHEN I FOUND OUT THE L.A. COUNTY SPENDS $270 MILLION YEARLY ON A PRISON SYSTEM MONITORING PAROLE VIOLATIONS AND JUVENILE DETENTIONS, YET AND YOU GUYS ARE IN TALKS OF OPENING A NEW $200 MILLION WOMEN'S PRISON NEXT TO CENTRAL, YET 1 PERCENT OF THAT BUDGET WE WOULD LIKE TO HAVE TOWARDS ALTERNATIVES FOR REHABILITATION THROUGH PERFORMING ARTS, BECAUSE A LOT OF THESE KIDS ARE MUSICIANS, ACTORS AND DANCERS AND PERFORMERS, BUT THERE ARE NO PERFORMING ARTS RESOURCE CENTERS FOR FREE ANYWHERE IN THESE NEIGHBORHOODS, YET THESE KIDS HAVE NOTHING ELSE TO DO BUT JOIN GANGS. SO WE ARE TRYING TO OPEN PERFORMING ARTS RESOURCES SPECIFICALLY IN THESE SIX TOWNS BECAUSE IT'S THE HIGHEST RATE OF GANG VIOLENCE. NOW ME, PER SE, I'M CURRENTLY FACING EVICTION RIGHT NOW BECAUSE MOST OF MY FINANCES HAVE GONE INTO FORMING THIS 501 C3. AND TO ADD INSULT TO INJURY, THE FOOD STAMP OFFICE SAY I OWE AN OVERPAYMENT, AS WELL. SO THERE'S A LOT OF UNBALANCE WITH THE FUNDING IN LOS ANGELES COUNTY. 

SUP. RIDLEY-THOMAS, CHAIRMAN: WE THANK YOU FOR YOUR TESTIMONY. IF YOU'D BE KIND ENOUGH TO TELL US YOUR CURRENT PLACE OF RESIDENCE OR WHAT PART OF THE COUNTY YOU RESIDE IN? 

ROSIE BALDERAS: SIXTH AND SPRING DOWNTOWN. I BELIEVE THAT'S DISTRICT 8? 

SUP. RIDLEY-THOMAS, CHAIRMAN: THAT'S THE CITY. AND IT'S RIGHT BETWEEN 1 AND 2. 

ROSIE BALDERAS: WELL GLORIA MOLINA, I BELIEVE, IS THE ONE THAT COVERS OUR AREA. 

SUP. RIDLEY-THOMAS, CHAIRMAN: SO IF THERE CAN BE SOME ASSISTANCE AFFORDED YOU, SUPERVISOR MOLINA, IS THERE SOMEONE FROM YOUR STAFF WHO CAN HAVE A CONVERSATION WITH YOU? IF YOU'D STEP RIGHT DOWN. SUPERVISOR MOLINA WILL HAVE ONE OF HER STAFF PEOPLE HAVE A CONVERSATION WITH YOU. 

ROSIE BALDERAS: OKAY, THANK YOU. 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU VERY MUCH FOR YOUR TESTIMONY. PATRICIA? 

PATRICIA MULCAHEY: YES. I WANT AN INVESTIGATION ONE INTO CIVIL RIGHTS VIOLATION. IN REGARDS TO NUMBER 2 THE HOSPITAL OFFICIALS ALL GOT BUSTED FOR MEDICAID AND MEDI-CAL FRAUD IN REGARDS TO QUEENS OF ANGELS. ALSO THEY WERE TALKING TO CHILDREN WHICH IS ANOTHER CIVIL RIGHTS VIOLATION. IF YOU HAVE YOUR CHILD AND GAVE BIRTH AT A HOSPITAL CALLED QUEENS OF ANGELS, PLEASE CONTACT ME. PATRICIA.MULCAHEY@YAHOO.COM. SO AGAIN IF YOU HAD YOUR CHILD TAKEN ILLEGALLY BY D.C.F.S., THAT USED SCARE TACTICS AND INTIMIDATION, AND -- WHICH IS ANOTHER CIVIL RIGHTS VIOLATION, PLEASE CONTACT ME. THIS IS THE NUMBER 661-305-3915. AGAIN, IF YOU CANNOT CONTACT ME THROUGH THAT NUMBER YOU CAN ALWAYS GO TO MY WEBSITE WHICH IS PATRICIA.MULCAHEY@YAHOO.COM. NOW NUMBER 2, YOU TALK ABOUT CIVIL RIGHTS VIOLATIONS, MOLINA, AGAIN I'M GOING TO YOU. YOU SAID YOU WERE GOING TO INVESTIGATE THE I.E.P.S. THAT HAS YET NOT TO BE DONE WITH WRITING THE ARMS LETTER. SO I ASKED FOR INVESTIGATION A LONG TIME AGO. NOW WITH REGARDS TO BLUE RIBBON COMMISSION, I HAD COMMISSIONER HOROWITZ STATE THAT PARENTS DO RECEIVE RETALIATION. WHEN I WORKED AS A WHISTLE BLOWER, SEPTEMBER 4, 2001, WHEN I MET WITH THE AUDIT MANAGER, THOMAS LEEHAN, WHICH WAS MONTEREY PARK, THEY TARGETED OUR FAMILY, OKAY? BECAUSE I HAD THEIR STUPID LITTLE C.E.O. FIRED, NAMED ANITA BOCK. SHE SHOULD HAVE BEEN ARRESTED, ALL RIGHT? AGAIN, I WOULD ASK THAT SHE HAS SOME FAMILY MEMBERS THAT WORKS FOR THE SHERIFF, ALL RIGHT? NOW, NOT THE HOSPITAL -- YOU HAVE -- UPSTAIRS YOU HAVE INTERNAL AFFAIRS. SURPRISE, SURPRISE. ALL RIGHT? I HAVE SHERIFFS TARGETING ME IN REGARDS TO L.A. TIMES, THE ANTELOPE VALLEY SHERIFFS THAT WERE CORRUPT. YOU HAD IT THERE ALSO THERE IN SANTA CLARITA. FALSE SHERIFF'S REPORT IN REGARDS TO -- 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU. ALL RIGHT. WE'LL NOW PROCEED. ARNOLD, OSCAR AND DAVID IN THAT ORDER. 

ARNOLD SACHS: YES, THANK YOU. I'M SORRY TO PICK ON METRO, BUT CONGRATULATIONS ON GETTING THE FUNDING FOR THE CRENSHAW LINE. BUT QUICK HISTORY HERE. THIS IS FROM 2012, THE CRENSHAW LIGHT RAIL PROJECT, WHICH IS ESTIMATED TO COST $1.4 BILLION. THIS IS FROM JANUARY -- THIS IS FROM 2012. THE FEDERAL TRANSIT ADMINISTRATION HAS ISSUED ITS FINAL APPROVAL OF A PLAN FOR $1.72 BILLION TRANSIT LINE ALONG THE CRENSHAW BOULEVARD. AND THIS IS FROM JUNE 28, THE COUNTY METROPOLITAN BOARD OF TRANSPORTATION UNANIMOUSLY APPROVED THE CRENSHAW LINE'S $2.6 BILLION BUDGET. THAT'S QUITE A GROWTH. MEASURE R FUNDING. BUT DO YOU KNOW WHAT THE BEST THING ABOUT THE CRENSHAW LINE IS? THE CITY OF INGLEWOOD IS GETTING A BILL FOR 3 PERCENT LOCAL RETURN. AND WITH THE LOAN THAT THEY GOT, THE $565 MILLION FOR TIFFIA, THEY'RE PAYING INTEREST ON A LOAN. THAT'S NOT DEDUCTED FROM THE COST OF THE LINE, THAT'S INCLUDED IN THE COST OF THE LINE. THAT'S SO WILD. MORE UNBELIEVABLE STUFF FROM THE BOARD AT METRO, WHICH YOU HAVE NO IDEA ANYTHING ABOUT. BUT AGAIN, THAT BEING DONE, DON'T CONFUSE ACTIVITY WITH ACHIEVEMENT, SOMEBODY SAID LAST WEEKEND. ALMOST FELL OUT OF MY CHAIR. I BELIEVE PART OF THAT PYRAMID THAT WAS MENTIONED BY JOHN, COACH WOODEN WAS ETHICS AND INTEGRITY. YOU KNOW THOSE TWO WORDS ARE PROBABLY FOREIGN AROUND THIS HORSESHOE. AND I'D LIKE TO POINT OUT ANOTHER COACH, THIS IS FROM AN ITEM THAT I WAS GOING TO BRING UP, MENTIONED THAT THE BOARD IS ON A FULL-COURT -- BY THE WAY, ARE YOU FAMILIAR WITH JACKIE CHILD, SIR, BY ANY CHANCE? DO YOU KNOW WHO THAT CHARACTER WAS? HE WAS A CHARACTER FROM SEINFELD. HE WAS FAMOUS, HIS QUOTE WAS "YOUR FACE IS MY CASE" HE WAS DEFENDING KRAMER. SO, YOU, SIR, SAID "THE BOARD IS IN A FULL-COURT PRESS" AND, SIR, AS COACH, YOUR PRESS IS A MESS. 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU FOR YOUR TESTIMONY. WE WILL PROCEED WITH THE BALANCE OF THE SPEAKERS, OSCAR JOHNSON, DAVID SERRANO AND, FINALLY, TERRY SIGMUND, IF YOU'D COME FORWARD, SHE WILL BE THE FINAL SPEAKER AND WE'LL CLOSE PUBLIC COMMENT AFTER HER. MR. JOHNSON, THE FLOOR IS YOURS. 

OSCAR JOHNSON: MY NAME IS OSCAR, I SPEAK FOR THE OPPRESSED. I SPEAK FOR THE STRUGGLING POOR. AND I SPEAK FOR CORPORATE CHANGE. I'D LIKE TO SPEAK A LITTLE ABOUT RELIGION AND SPEAK ABOUT SOCIAL RESPONSIBILITY. I THINK AMERICA WOULD BE A -- AMERICA MUST BE REMADE. AMERICA MUST CHANGE. AMERICA MUST CHANGE IN DIRECTION OF THE TRUE RELIGION THAT AMERICA WAS FOUNDED UPON. OUR FOUNDING FATHER, JOHN ADAMS, SAID DEMOCRACY SHOULD NEVER RULE OVER MORALS. IT IS PROPHESIED IN THE BIBLE IN THE SCRIPTURE THAT MODERN BABYLON HAS FALLEN. BABYLON REPRESENTS AMERICA. BECAUSE SHE HAS BECOME A CAGE FOR EVERY FILTHY AND UNCLEAN BIRD TO LAY IN. AMERICA HAS FALLEN BECAUSE OF HER MORAL VALUE. BLACK AMERICA SHOULD TURN OURSELF TO THE TRUE RELIGION. THE TRUE RELIGIONS CAN HELP US THINK BETTER, TO HELP US SEPARATE TRUTH FROM FALSEHOOD. TRUE RELIGION CAN HELP US OUR MORALS MUCH VALUE BECAUSE WE ARE ATE A VERY LITTLE MORAL POINT TODAY. BUT WHITE AMERICA STILL LOOKS AT BLACK AMERICA AS THEIR SLAVES AND SLAVEHOLDERS. ALL MINORITIES IS THE NEW SLAVE LABORERS OF AMERICA. WHILE WE SEE THESE MANY CORPORATIONS HAVE MINORITIES WORK IN BUSINESS IN THE BOTTOM BUT THE TOP OF THE CORPORATION THE C.E.O. MAKING SIX DIGIT FIGURES. WE SHOULD STOP DRUGS FROM COMING INTO AMERICA. WE SHOULD STOP DRUGS FROM BEING MADE IN AMERICA. WE SHOULD STOP GUNS FROM COMING INTO AMERICA. WE SHOULD STOP GUNS FROM COMING INTO AMERICA. BUT THE SECOND AMENDMENT TO THE CONSTITUTION SAID THE RIGHT TO BEAR ARMS MEANS THE RIGHT TO DEFEND YOURSELF. BUT WE ARE USING GUNS ON OFFENSE. AND THE FIRST GUN THEY LET IN AMERICA WAS A SHOTGUN, THEN THE RIFLE. AND NOW WE'VE GOT THE HANDGUN. AND THE HANDGUNS AND DEVICES, -- OUR FREEDOM. IT TAKES AWAY FROM OUR FREEDOM. FREEDOM NEED TO BE CLEAN. IF WE'RE NOT CLEAN AND FREE AND TRULY MORAL, WE ARE NOT FREE. 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU FOR YOUR TESTIMONY. MR. SERRANO FOLLOWED BY MISS SIGMUND AND THEN WE'LL BE DONE WITH THE PUBLIC COMMENT. 

DAVID SERRANO: THE HOLY TRINITY IS THE ONE AND ONLY GOD, THE CREATOR OF HEAVEN AND THE UNIVERSE, AMEN. JESUS CHRIST IS GOD, AMEN. INFINITE JESUS CHRIST WAS CONCEIVED BY THE POWER OF THE HOLY SPIRIT AND BORN OF THE VIRGIN MARY. JESUS NEVER SINNED. THE LORD JESUS CHRIST PREACHED THE WORD OF GOD, FORGAVE PEOPLE'S SINS AND HE DID MANY MIRACLES INCLUDING RAISING THE DEAD TO LIFE. CHRIST WAS BETRAYED BY A SINNER INTO THE HANDS OF SINNERS. ALL PEOPLE ARE SINNERS AND FALL SHORT OF THE GLORY OF GOD. AND THE PUNISHMENT FOR SIN IS DEATH AND HADES, WHICH IS EXCLUSION FROM HEAVEN. BUT THE GIFT OF GOD IS LIFE EVERLASTING IN JESUS CHRIST, AMEN. I REITERATE THE FACT JESUS NEVER SINNED. INNOCENT JESUS CHRIST WILLINGLY SHED HIS PRECIOUS, HOLY BLOOD AND HE DIED IN OUR PLACE ON THE CROSS FOR OUR SINS AS THE PERFECT, ALL SUFFICIENT SACRIFICE OF ATONEMENT FOR THE SINS OF THE WORLD, TAKING UPON HIMSELF THE PUNISHMENT OF DEATH IN HADES WHICH ALL PEOPLE DESERVE AS OUR SUBSTITUTE BY THE GRACE OF GOD, EFFECTIVE THROUGH FAITH IN THE LORD JESUS CHRIST. AND AFTER HOLY JESUS' FLESH BODY DIED ON THE CROSS, HOLY GOD ALMIGHTY, JESUS' SPIRIT AND SOUL DESCENDED INTO HADES AND JESUS PROCLAIMED THE WORD OF GOD TO THE IMPRISONED SOULS AND SPIRITS OF THE DEAD THREE DAYS WHILE JESUS' FLESH BODY WAS TAKEN DOWN FROM THE CROSS AND WAS ENTOMBED. THEN ON THE THIRD DAY WHEN HOLY GOD ALMIGHTY CHRIST JESUS' SPIRIT AND SOUL ASCENDED OUT OF HADES OUR GOOD LORD, SAVIOR, AND REDEEMER, JESUS CHRIST RESURRECTED AND HE LEFT THE TOMB. THEN JESUS CHRIST APPEARED TO HUNDREDS OF HIS DISCIPLES OVER THE COURSE OF 40 DAYS. THEN JESUS ASCENDED INTO HEAVEN. JESUS CHRIST IS TRANSFIGURED AT THE RIGHT HAND OF GOD, THE FATHER ALMIGHTY IN HEAVEN, AMEN. BY THE GRACE OF GOD BECAUSE WE BELIEVE IN JESUS CHRIST, CHRISTIANS RECEIVE LIFE EVERLASTING WITH GOD IN HEAVEN, AMEN. ALL PEOPLE WHO DIE AS UNBELIEVERS RECEIVE EVERLASTING PUNISHMENT FOR THEIR OWN SINS. ALL MUSLIMS SHALL BURN IN THE LAKE OF BURNING SULFUR. REPENT AND BELIEVE IN THE LORD GOD JESUS CHRIST AND YOU WILL INHERIT LIFE EVERLASTING WITH GOD IN HEAVEN AMEN. 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU. MISS SIGMUND? 

TERRY SIGMUND: THE D.C.F.S. IS KNOWN FOR THEIR VAST FRAUD. IN MY OWN CASE, MY CHILDREN HAD BEEN LABELED AS DELAYED AND THUS THAT'S HOW IT WAS DEFRAUDING THE TAXPAYERS. THE D.C.F.S. GETS A LOT MORE MONEY WHEN THEY HAVE SPECIAL NEEDS CHILDREN OR WHATEVER LATEST P.C. TERM IS. IN MY OWN CASE, MY ONE CHILD, ACCORDING TO THE REGIONAL CENTER WAS ACTUALLY ASSESSED AS HIGHLY ADVANCED, NOT SEVERELY DELAYED. HOWEVER, SINCE THAT DIDN'T FIT THE NARRATIVE, THESE PAPER WORKS WERE SUPPRESSED. THEY WERE NOT GIVEN TO THE COURTS, THEY WERE NOT GIVEN TO MY LAWYER NOR ME. THEY WERE NOT GIVEN TO THE DOCTOR. MEANING THE TAXPAYERS FOR MANY, MANY YEARS HAVE BEEN PAYING FOR A DELAYED CHILD THAT WAS ACTUALLY ADVANCED. FOR EXAMPLE, HIS FINE MOTOR SKILLS HE WAS PLACED AT 27/28 MONTHS WHEN HE WAS ONLY 17 MONTHS. THAT IS HARD TO IMAGINE FOR A DELAYED CHILD. MY OTHER CHILD, FOR EXAMPLE, WAS NEVER SPOKEN TO IN HIS NATIVE TONGUE, MEANING WHEN THE D.C.F.S. GRABBED HIM, HE WAS COMPLETELY SHUNNED INTO A WORLD OF SILENCE SINCE HE SPOKE GERMAN, NOBODY EVER SPOKE TO THAT BOY IN HIS LANGUAGE. MANY BILINGUAL FAMILIES, BASED ON THE RECOMMENDATION OF EXPERTS, FIRST TEACH THEIR CHILDREN THEIR NATIVE TONGUE BEFORE THEY TEACH THEM THE OTHER TONGUE SO THEY WILL BE BILINGUAL. MY POOR CHILD HAS BEEN LABELED AS SPEECH DELAYED. IMAGINE GOING TO ANOTHER COUNTRY AND YOUR CHILD IS SPEECH DELAYED BECAUSE THEY REFUSE TO TALK TO THEM IN ENGLISH AND NOW LET'S REVERSE IT AND YOU KNOW WHAT HAPPENED TO US. BESIDES THE INHUMANITY, THE UNSPEAKABLE INHUMANITY TOWARDS MY CHILD AND US AS A FAMILY, THE MONEY THAT THEY DEFRAUDED BY HAVING HIM LABELED THAT WAY IS SOMETHING THAT YOU DON'T SEEM TO BE THAT INTERESTED INTO CHECKING OUT. MY THIRD CHILD WAS AN HONOR STUDENT AND FOR SOME STRANGE REASON ONCE IN THE HANDS OF D.C.F.S. WAS LABELED A BAD HONOR STUDENT. WHATEVER THAT MEANS, A PERSON WITH A BRAIN WILL NEVER KNOW. BUT I'M SURE THE FOOTPRINTS ARE SPACED TO SEE WHAT THE INTENT IS. AND MY RELIGIOUS RIGHTS, I SEEM TO STILL NOT HAVE ANY. 

SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU FOR YOUR TESTIMONY, YOUR TIME HAS EXPIRED. THANK YOU. MADAM EXECUTIVE OFFICER. 

SACHI HAMAI, EXEC. OFFICER: IN ACCORDANCE WITH BROWN ACT REQUIREMENTS, NOTICE IS HEREBY GIVEN THAT THE BOARD OF SUPERVISORS WILL CONVENE IN CLOSED SESSION TO DISCUSS ITEM NO. CS-1, CONFERENCE WITH LEGAL COUNSEL REGARDING SIGNIFICANT EXPOSURE TO LITIGATION, ONE CASE; ITEM NO. CS-2, PUBLIC EMPLOYMENT CONSIDERATION OF CANDIDATES FOR THE POSITION OF INSPECTOR GENERAL FOR OVERSIGHT AND MONITORING OF THE SHERIFF'S DEPARTMENT, ITEM NO. CS-3, DEPARTMENT HEAD PERFORMANCE EVALUATIONS; ITEM NO. CS-4, CONFERENCE WITH LABOR NEGOTIATOR WILLIAM T FUJIOKA AND DESIGNATED STAFF; AND ITEM NO. CS-5, CONFERENCE WITH LEGAL COUNSEL REGARDING INITIATION OF LITIGATION, ONE CASE, AS INDICATED ON THE POSTED AND SUPPLEMENTAL AGENDAS. 
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